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Chapter 1: What is New in Dragon 11

[bookmark: _Toc320038438]Chapter 1: What is New in Dragon 11
The way Dragon interfaces with the user has changed.
The DragonBar is designed to help the user discover and access important tools; in addition, it keeps important status indicators close together: Dragon logo, microphone status, the text control indicator, the recognition mode indicator and messages from Dragon.
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[bookmark: _Toc320038439]Menus 
[image: ]
Profile Menu: formerly the NaturallySpeaking menu, it contains only items related to the user profile including backup and restore. 
Tools Menu: the biggest change here is that the Accuracy Center has been moved to the Help Menu under "Improve My Accuracy"
Vocabulary menu: replaces the Words menu and only includes functionality for vocabulary related features. 
Modes menu: houses various dictation modes that were formerly in the Words menu.
Audio menu: formerly the Sound menu
Help Menu: features the Accuracy Center and the new Dragon Sidebar
Detailed information about each menu can be located in Chapter 2.
Accuracy Center: The Accuracy Center is more informative and now helps you to find and access tools that will help refine your user profile and improve accuracy. It also has links to Dragon Options and Auto-Formatting Options.
[bookmark: _Toc319744432][bookmark: _Toc320038440]New results display, and the former results box
As the user speaks, Dragon 11 indicates that it is processing by displaying a small dragon logo at your insertion point, and when the user pauses, the dictated words appear in the document. Nuance research shows that this enables most users to dictate better, without being distracted by seeing the preliminary results accumulating in the Results Box, as in previous versions. The traditional results box is still available from the view tab of the Options dialog box.
 Commands will still appear in a small box with a blue border and the former results box with??? Will now display as a box reading "Please say that again"
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[bookmark: _Toc319744433][bookmark: _Toc320038441]The Dragon Bar and Icons 
The DragonBar is the main Dragon toolbar used to control the Dragon software. The appearance and location of some features have changed.
The DragonBar contains the following controls, starting from the left:
The Dragon Icon: A redesigned Control Menu Is Accessible by Clicking the Dragon logo to the left of the microphone icon or right-click anywhere on the DragonBar to display a menu that controls how the DragonBar looks and acts on your screen.
[image: ]
The Microphone Icon: the microphone icon displays on the DragonBar and in the Windows taskbar. Click the microphone icon to turn the microphone on and off. If the microphone is in the upright position within a green circle, the microphone is on and Dragon is listening.  When the microphone is slanting within a yellow circle, the microphone is asleep and Dragon is temporarily not listening. When the microphone is lying down within a red square, the microphone is turned off. A grayed out microphone means no user profile is loaded and you cannot dictate.
  [image: ]

The Volume Display: When Dragon hears well, the volume display turns green and expands to the right.  A pause between words causes the volume display to turn yellow and contract.  No color displays with the microphone is turned off or is not responding.  The display turns gray when the microphone is in sleep mode.
[image: ]
Text Control Indicator: formerly called "Select-and-Say” The text control indicator shows the level of dictation support a user can expect in various applications. If Dragon has full text control, the DragonBar shows a green checkmark; previous versions used a green ball. By contrast, where Dragon has only basic text control the checkmark is gray; in previous versions, it would have been a gray ball.


[image: ]
The Recognition Mode Indicator: The recognition mode indicator shows Dragon's current dictation mode. The modes include Normal Mode, Dictation Mode, Command Mode, Numbers Mode, Spell Mode, (default is normal mode.) 
Recognition modes are now indicated by symbols as well as in the message indicator.
· 

· Normal mode-Dragon’s default mode of dictation
· Dictation mode-Dragon listens for dictation of words and punctuation only. Nothing you dictate is interpreted as a command
· Command Mode-Dragon listens for commands only.  Nothing you dictate is interpreted as words, numbers, or letters
· Numbers mode-Dragon listens for dictation of individual numbers, commands, and punctuation only.
· Spelling mode-Dragon listens for dictation of individual letters, numbers, commands, and punctuation.

 [image: ]

The Message Area: To the left of the menus is a message display area, which shows Dragon's current status, such as whether the microphone is on or off, what mode you're in,  and what you can dictate in that mode.
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Other improved features and changes
Correct or format multiple instances of text:  Now when the users tell Dragon to select, correct or format text, if there are multiple instances of the same text, Dragon displays a number next to each instance. The user can then choose to apply the commands to one or all of the numbered items.
[image: ]
Improved Command and Control: Dragon 11 introduces new commands that act on multiple mouse clicks and key strokes. With the new commands, it is faster and easier to open applications, or switch between open programs or Windows.

To list all programs or open documents: say, “List Programs" or “List All Windows", then choose the number of the window you want.

[image: ]
Speedier Set up and Greater Accuracy: Improve recognition when multiple processors are available. Dragon now automatically detects computers with multiple processors.
Don't recognize that word: A new option on the correction menu: Dragon now enables the user to prevent certain words from being recognized. For example, if the user dictates the name Cassity often and Dragon always hears Cassidy, use "Don't Recognize That Word" on the corrections menu to turn off a particular word such as Cassidy.
Audio Quality Alerts: Misrecognitions are caused by poor audio input. To ensure that it receives the highest quality audio, Dragon 11 can detect a drop in audio quality reminding the user of typical causes, including microphone placement, excessive background noise, or a low battery on Bluetooth microphone.
Reduced Setup Time: The way you create a new user profile is faster and more flexible, so you can start dictating sooner.
Open User Profiles Dialog Box Optimized for Roaming: This could be helpful for upfront interviewing stations if there is more than one Dragon user in the office using the same interviewing station. It is a faster and easier system for displaying roaming user profiles. Administrators can still configure Dragon to display the traditional open user profiles dialog box as required.
Support for Office 2010: Dragon 11 provides compatibility with Microsoft Office 2010 including full text control and Natural Language Commands.
Reduced Memory Usage during Acoustic Optimization: Dragon 11 uses significantly less memory than previous versions during optimization. Running the Acoustic Optimizer regularly is important for improving your User Profile’s accuracy over time, and it is easier to do in Dragon 11.
Support for Word2110 and Open office.ORG Writer: Is compatible with 32-bit and 64-bit versions, including Full Text Control and Natural Language Commands.
Easier Names for Popular Programs: Dragon now recognizes shorter names for popular Windows programs. For example, now you can say "Open Microsoft Word" rather than “Open Microsoft Office Word 2010.”
Display Searched Text before Performing Searches:  In Dragon 10, Web and desktop search commands execute the search automatically. In Dragon 11, you can edit the search string before it is sent to your browser. The new Edit Search Keywords dialog box provides option to revise or replace the search keyword.
Shift Control Mouse Click Voice Commands: Dragon provides new voice commands for pressing the shift and control keys by voice in conjunction with right or left clicking the mouse, this will provide greater flexibility with certain Windows programs.
More File Formats for Use with Digital Reporters:
Playback Options Added to the Text-To-Speech Options:
Easier Accuracy Tuning and Data Collection: Scheduling accuracy tuning and data collection is easier, and does not require a Windows Username and password. The accuracy tuning will help Dragon to refine your profile based on what you have dictated, corrected, and trained.  (This will need to be scheduled when your computer is on and Dragon is closed)




[bookmark: _Toc320038442]Chapter 2: The DragonBar
The DragonBar is a toolbar that appears at the top of the screen when Dragon starts. The appearance and behavior of the DragonBar can be changed to suit the user. To change the position of the DragonBar, right-click anywhere on the DragonBar, a display menu will open, that controls how the DragonBar looks and acts on the screen. The new redesigned DragonBar contains the following features starting from the left side.
Dragon Logo Icon: Click the Dragon icon (or right-click anywhere on the DragonBar) to display a menu that controls how the DragonBar looks and acts on the screen.
Microphone Indicator: The microphone icon displays on the DragonBar and in the Windows taskbar. Click the microphone to turn the microphone on and off. Green and up right the microphone is on, yellow and slanting the microphone is asleep, if it is red and laying down the microphone is off.
Audio Indicator Box: Volume level is indicated by color. When Dragon hears well, the volume display turns green and expands to the right. When you pause between words, the volume display turns yellow and contracts. If the volume display is red the volume is too loud. No color displays when the microphone is turned off or is not responding. The display turns gray when the microphone is in sleep mode.
Text Control Indicator:  Shows the current level of dictation, selection, and formatting support. (Green checkmark) Dragon has full text control of the active field; (gray checkmark) has basic text control. The previous versions of Dragon indicated the current dictation support level with the Select-and-Say indicator (a green or gray ball)
Recognition modes Indicator:  Displays next to the Text Control Indicator identify Dragon’s current recognition mode. Modes are; normal mode, dictation mode, command mode, spell mode or numbers mode.
Message Status Center:  A visual area for all items that change as a user dictates, Mode, Microphone status etc
The Menu: The DragonBar menus have changed. Some names have changed and in some cases functions have been moved from one menu to another menu.


[bookmark: _Toc320038443]Profile menu 
New User Profile: Opens New User dialog box.  Leads user through the steps to create a new user profile 
Add dictation source to current user profile: Opens New Dictation Source dialog box, add or change the dictation device without creating a new user
Add vocabulary to current user profile: Opens New Vocabulary dialog box, add a vocabulary list to a current user “see help” to further explain the how and why of doing this.
Open user profile: Opens dialog box that allows you to open and view properties of an existing user, or add a new user. The source buttons allows a user to delete or add a dictation device. The cancel button simply closes the dialog box, does not undo any actions. 
Open recent user profile:  The Open Recent User dialog box is just another way to open another user files.
Close user profile: Closes current user profile without saving user profile.
Save user profile: This feature saves user speech files.
Manage user profile: Select the manage users dialog box to create a new user profile, delete a user, rename a user or view the User Profile Properties.  The Advanced button allows user to import and export vocabularies as well as backup and restore files. The Help button gives information on each of the above options.
Prepare user profile for use: Opens the Audio Setup Wizard.
Backup user profile or Restore user profile: Backs up the selected User Profile in the location specified in the Administrative Settings dialog box Miscellaneous tab, ( Tools > Administrative Settings > Miscellaneous). The <default> backup location for all Dragon User Profiles is the Windows Documents folder. You can change the Backup location to any directory where Windows has both read and write permissions. Restores any backed up User Profile. The files are restored and the User Profile has the word "Restored" appended to it.
Close Dragon Bar: Close Dragon NaturallySpeaking


[bookmark: _Toc320038444]Tools Menu 
Dragon Pad: Opens the Dragon word processor
Dictation Box:  Opens the Dictation Box; it can also be opened by voice command “Show Dictation Box” or “Open Dictation Box”
Transcribe Recording:
Auto Transcribe Folder Agent:
Add New Command: Opens the My Commands Editor dialog box allowing user to add a new command.
Command Browser: The Command Browser is the center for all voice commands.  Users can create, train and modify commands.
Recognition History: The Recognition History displays a list of what DNS transcribed during dictation. 
[bookmark: kanchor1435]Auto-formatting Options: The formatting window allows the user to choose whether or not to automatically format text. It allows the user to specify which things to automatically format.
[bookmark: _Toc161762058]Auto-Formatting: The Auto-Formatting window allows the user to choose whether or to automatically format text, and allows user to specify which things they would like to be automatically formatted. 
Automatically format text: When checked it allows the user to turn on different forms of automatic number word formats.  
Web and E-mail addresses: Check this box to turn on automatic e-mail and web address formatting, which lets the user dictate these in a natural manner. It concatenates names, web and e-mail addresses and recognizes the word "at" as the @ sign.
[bookmark: 177]Street addresses: Turns on automatic formatting of postal addresses.
Abbreviate titles:  Inserts abbreviated versions of any title in the default lexicon.
Dates: Turns on automatic formatting of dates according to the format you select in the combo box.
Common abbreviations: Select this box to have Dragon NaturallySpeaking recognize most standard abbreviations while dictation if you say “abbreviated” after the word.
Expand contractions: Select this box to have Dragon NaturallySpeaking recognize contractions while transcribing dictation.
Prefer 5 million over 5,000,000: Inserts numbers as a combination of text and Arabic numerals.
Numbers, if greater than or equal to ‘n’: Inserts numbers as numerals if they are equal to or greater than the value shown in the drop-down list. If the number is less than the chosen value, the number is spelled out.
Units of measure: Turns on automatic formatting of standard units of measure, such as feet and inches.
ISO currency codes: Select this box to have Dragon NaturallySpeaking use the currency character and format specified on the Currency tab of the Regional Settings tool in your Windows Control Panel.
US Phone numbers: Turns on automatic formatting of telephone numbers when spoken in a sequence of seven or ten numbers.
Prices: Turns on automatic formatting of standard forms of currency, such as dollars.
Times: Turns on automatic formatting of standard time formats.
UK and Canadian postcodes: Check this box to allow automatic formatting of Canadian and UK postal codes. 
Other numbers: Enables the formatting of all numbers not covered by other options on this dialog box, such as negative numbers, numbers with punctuation, fractions, decimals, and roman numerals.
US Social Security Numbers: Check this box to allow formatting of numbers. 
Automatically add commas and periods: Check this box to have Dragon NaturallySpeaking automatically add commas and periods in your dictation.
Insert two spaces after period: Will add two spaces after the end of a sentence. Clear this check box to add only one space.
Options: Options are discussed in detail in Chapter 3.
[bookmark: _Toc320038445] Vocabulary Menu 
Learn from specific documents: From this dialog box the user will be able to improve their accuracy by adapting document writing style and adding new words to the vocabulary.
Learn from sent e-mails: From this dialog box the user will be able to improve their accuracy by adapting email writing style and adding contact names to the vocabulary.
Add new word or phrases: This option allows the user to add a single word to the vocabulary and train it.
Open Vocabulary Editor: The user can add, delete, and train new words. The user can change word properties including the ability to specify two alternate written forms and the context in which the alternate form will be used. Select the word to modify and click “Properties”
Import list of words or phrase:  Allows the user to import new words and phrases from lists. 
Export custom word or phrase list:  Allows the user to export words and phrases from lists.
Manage Vocabularies: The Manage Vocabulary dialog box allows the user to open, delete, and create new vocabularies as well as import and export vocabularies.
Open Recent Vocabulary: The Open Recent Vocabulary dialog box allows the user to switch between vocabularies. For example if you have installed both the medical and legal vocabularies, you may switch between them.
[bookmark: _Toc320038446]Modes Menu 
Normal Mode: This is the default mode for dictation.
Dictation Mode: Select this mode if you do not intend use voice commands.
Command Mode: Select this mode if you do not intend use dictation.
Numbers Mode: When Using Numbers Mode, numbers will be in Arabic. You can still use commands while in Numbers Mode.
Spell Mode: Use to dictate letters, numbers, and punctuation. You can still use commands while in Spell Mode.
[bookmark: _Toc320038447]Audio Menu 
Playback: Lets you hear your dictation so you can easily determine what you meant to say.
Read That: Uses text to speech to have text on your screen read aloud in a computer voice.
Check Microphone: Opens the Check Microphone Window, follow prompts to re-  check the quality of your audio input.
Improve Recognition of Word or Phrase: Opens Training window to allow you to train a word or phrase.
Read Text to Improve Accuracy: Opens the General Training window.
Launch Accuracy Tuning: Opens Acoustic and Language Model Optimizer
[bookmark: _Toc320038448]Help Menu
Improve my Accuracy: Opens the Accuracy Center.
Performance Assistants: Opens Dragon Performance Help Window.
Help Topic: Opens the standard Windows help file for Dragon NaturallySpeaking.
Tip of the Day: Gives access to the tip of the day.
Dragon Sidebar: Opens the Dragon Sidebar (see Chapter 4 for details).
Tutorial: Gives access to the Dragon naturally speaking tutorial.
Check for Updates: 
Dragon on the Web: Opens to the Nuances web site, gives you access to resources, including Frequently Asked Questions, Customer Service information and Technical Support content.
Technical Support: Opens to the Nuances Home page
Register Online: Opens to the Nuances Home page
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About NaturallySpeaking: Shows software information
[bookmark: _Toc320038449]Chapter 3: Dragon NaturallySpeaking Options
The Options dialog box lets you customize Dragon NaturallySpeaking. To access the Options dialog box, select the Tools Menu and then Options.
The Restore Defaults button resets all the options on the current page to their default setting.
Unless otherwise indicated, changing these options only affects the current user profile: any other users keep their own settings
[bookmark: _Toc320038450]Correction Tab
The Correction options affect the Corrections menu, which is the list of alternate recognitions that appears when you select words in your document.
"Select" command brings up Correction menu: Checking this will cause the Correction menu to appear every time you select a word or phrase using "Select".
"Select “commands search backwards: Checking this will cause the selection commands to search for matching text backward from the insertion point. 
"Correct" command brings up Spell dialog box: Checking this will cause the Spell dialog box to appear every time you correct a word or phrase using "Correct".
Automatically add words to vocabulary: Select this box to add the corrected word automatically to the active vocabulary.
Automatic playback on correction: Checking this will automatically enable the playback of your dictation when you make a correction.	
Corrections Menu:
Show only the choices: Checking this will display only the alternate words or phrases on the Correction menu rather than the additional commands.
Anchor: Checking this will lock the corrections menu in its current location until you drag it to a new location.
Enable double-click to correct: Checking this will open the correction menu when you double-click a word.
Show no more than "n" choices: Controls the maximum number of choices that appear in the Correction menu. 
[bookmark: _Toc320038451]Commands Tab
Pause required for commands:  Adjusts the time interval considered a pause before you speak commands. The default setting is 250 milliseconds (.25 seconds). You should normally leave this at its default setting.
Enable mouse motion commands: Select this checkbox to allow you to use mouse motion commands such as “Move mouse left", "Faster" and "Slower".
Speed: Click the speed button to select the mouse motion being between 1 as the slowest and 25 as the fastest.
Enable HTML support: Allows you to enable commands in HTML Windows and allows you to choose whether you are required to "Click" to select hyperlinks in HTML Windows. This check box should be checked.
Enable commands in HTML Windows: Checking this allows the use of commands designed specifically for use with Internet Explorer. Any change in this option does not take effect until you restart Dragon NaturallySpeaking and then start Internet Explorer. This check box should be checked.
Require "Click" to select hyperlinks in HTML Windows:  If you select this check box, you are required to speak the word "Click" to select a hyperlink. By default, this feature is turnoff.
Require "Click" to select menu or control: Checking this box will require you to speak the word "Click" to select a menu command or Windows control. By default, this feature is off.
Enable recognition mode switching commands: Enabling recognition mode switching, allows users to dictate and say the mode switching commands interchangeably. Turning on recognition mode switching this enables your ability to switch between modes.
Enable Web search commands: Select this check box to enable Web search commands to search the Internet using commands that are patterned on normal speech.
Displays search text for performing search: Select this check box to displays your search text before performing the search, allowing you time to edit.
Enable Desktop search commands: Select this check box to enable Desktop search commands that let you search Windows desktop using commands that are patterned on your normal speech.
Enable E-Mail and Calendar commands: Select this check box to enable Voice Shortcuts for E-Mail and Calendar Outlook that will let you control Outlook's e-mail and calendar functions using commands that are patterned on your normal speech. This check box should be checked.
Variable Delimiters: Used by Text-and-Graphics commands that incorporate Voice (variable) Fields. Voice Fields are variable fields where the user can later type or dictate a specific value. Change the variable delimiting characters, specify character for the Left delimiter and a character for the Right variable delimiter. Do not use numbers or letters.
To clear Delimiters in MyCommands: You can dictate "Clear delimiting characters” to remove the Voice Field delimiters.
Natural Language Commands: checking this allows the use of commands you can use with most word processors. This feature uses an additional 8 MB of memory.  This check box should be checked.
You can disable and enable Natural Language support globally and specifically in the following applications:
· Microsoft Word	
· Microsoft Excel
· Microsoft PowerPoint
· Corel WordPerfect
Disabling some, Natural Language commands may help to increase your system performance.
[bookmark: _Toc320038452]View Tab
Use the View tab to control the behavior and appearance of the DragonBar, Dragon Icon and Results Box.
DragonBar Mode: Lets you choose where you want the DragonBar on your screen.
	Docked to Top: The DragonBar appears along the top of screen.
Docked to Bottom: The DragonBar appears along the bottom of the screen.
Floating: The DragonBar appears as a window on top of any other open window on your  screen. You can drag the DragonBar to reposition it.
Cling: The DragonBar is attached the top of the currently active window.
Tray Icon Only: The DragonBar Menu appears only when you right –click on the microphone icon in the system tray. 
Show messages: Check this box to display useful hints that appear in the DragonBar periodically.
Show extras: Check this box to display the extras toolbar automatically every time you start the DragonBar.
Results Box
Anchor: Locks the results box in its current location until you drag it to a new location. Clear this check box To Allow the Results box to float around the window as you dictate.
Show Preliminary Results: Check this box to display Results box in place of Dragon icon.
Beep after Recognition: Check this box to have Dragon NaturallySpeaking beep each time it recognizes a word or phrase.
Auto-hide delay: Adjusts the length of time before the results box disappears after recognition. From a list, you can choose to Never Hide it or Never Show it, or you can set a delay after which it automatically hides itself; the default setting is Never Hide.
[bookmark: _Toc238226286][bookmark: _Toc319678477][bookmark: _Toc319678764][bookmark: _Toc320038453]Hot keys Tab
Use the Hot keys tab to specify hot key assignments.
Microphone on/off: Changes the hot key that turns the microphone on or off. The default is the plus key (+) on the numeric keypad.
Correction: Changes the hot key that opens the Correction menu. The default is the minus key (-) on the numeric keypad.
Force command recognition: Changes the hot key that forces words to be recognized as commands rather than dictation words. The default is the Control key.
[bookmark: 173]Force dictation recognition: Changes the hot key that forces words to be recognized as dictation words rather than commands. The default is the Shift key.
DragonBar menu:  Changes the hot key that opens the NaturallySpeaking menu on the DragonBar. The default is the asterisk key (*) on the numeric keypad.
Microphone sleep/on: Changes the hot key that causes the microphone to go to sleep or wake up. The default is the slash key (/) on the numeric keypad.
Press-to-talk: Changes the hot key that causes the microphone to turn on for as long as you hold down the key and turn off as soon as you release it. No default key assigned.
Dictation Box: Changes the hot key that accesses the Dictation Box. The default is the Control + Shift + D.
Playback: Changes the hot key that causes Dragon NaturallySpeaking to playback your dictation so you can more easily identify what you meant to say during correction. The default is the Shift + minus key (-) on the numeric keypad. 
Fast Forward: Changes the hot key that increases the play back speed. The default is the Shift + asterisk key (*) on the numeric keypad.
Next Field: Changes the hot key that selects the next variable (Voice field) in a text and graphics command. The default is Ctrl + Shift + N.
[bookmark: _Toc320038454]Playback /Text-to-speech Tab
Playback attributes
Playback volume: Adjusts the volume of the selection that you playback. You choose a value between 1 and 100. The default value is 100.
Playback speed: Adjusts speed of the selection that you play back. You can choose a value between 1 and 999. The default value is 150.
Fast-forward volume: Adjusts the fast-forward volume of the selection that you playback. You can choose a value between 1 and 100. The default value is 100.	
Fast-forward speed: Adjusts the fast-forward speed of the selection that you playback. You can choose a value between 1 and 999. The default value is 150.	
Rewind volume: Adjusts the rewind volume of the selection that you playback. You can choose a value between 1 and 100. The default value is 100.
Rewind speed: Adjusts the rewind speed of the selection that you playback. You can choose a value between 1 and 999. The default value is 150.
Play Rewind/Fast Forward sound 
When checked Dragon plays a sound when you fast-forward or rewind the selection. Deselect the checkbox to turn the sound off.
Text-to-speech attributes:
	Volume: Adjusts the volume of text-to-speech playback.
Pitch: Adjusts the pitch of text-to-speech playback if supported by your version of text-to-speech.
Speed: Adjusts the speed of text-to-speech playback.
Voice: determine the voice to use for text-to-speech playback.
Text-to-speech preview: Enter or paste text in this box and press the Read text button text-to-speech playback.
Read text: Clicking this button allows you to hear a sample reading of the text in the Preview box with the settings you selected.
Unload text-to-speech: Removes the text-to-speech engine from memory. Dragon NaturallySpeaking loads the text-to-speech engine the first time you use the text-to-speech command after starting Dragon NaturallySpeaking. The text-to-speech engine should not affect performance, so generally you will not need to unload.
[bookmark: _Toc320038455]Miscellaneous Tab
Use this tab to set miscellaneous options. Unless otherwise indicated changing options only affects the current user profile; any other user profiles keep their existing settings.
When the User Profile Opens:
Show the Dragon Sidebar: Specifies that the Dragon Sidebar displays when Dragon opens. By default, the Sidebar displays automatically when you open the Dragon user profile. If the sidebar is closed, you can open it any time by saying "Show Sidebar".
Have the microphone on the asleep: Specifies that Dragon automatically will put the microphone in Sleep mode when you start the program. You must say "Wake-Up “or "Listen to Me" before Dragon will recognize dictation or other commands.
Launch DragonPad: Opens Dragon pad when Dragon first starts.
When the User Profile Close:
Automatically save the profile changes: Saves changes to your User Profiles when exiting Dragon without displaying a dialog box asking you to confirm that you want the User Profiles saved.


Speed vs Accuracy
Speed vs Accuracy slider: Increases or reduces the number of words or phrases Dragon examines in its vocabulary as it processes your speech in order to find a match. Fastest Response, reduces the number of words or phrases examined, displays results faster with less accuracy, Most Accurate, increases the number of words or phrases examined during speech recognition displaying results more slowly with greater accuracy.
Uses menus that are compatible with screen readers: Selecting this option allows a screen reader program to read menu items out loud to vision-impaired users. Some screen readers have trouble-reading menus unless this option is turned on. If this option is on, the small icons next to menu items will disappear.
Voice enables menus and dialog controls: Selecting this box specifies that Dragon should use Microsoft Active Accessibility features that are required by some versions of Windows to control the menus and dialog boxes of certain applications by voice. Changing this option affects all user profiles.
Launch Dragon in QuickStart mode when Windows starts: Selecting this will cause Dragon NaturallySpeaking to load in the background when you start your computer. If Dragon is in QuickStart mode, the Dragon icon appears in the system tray.
Put the microphone to sleep after 5 min. of silence: Allows you to adjust the amount of time before the microphone returns to sleep mode. From 5 min to 120 min. is the range of options. (5 min. is the recommended time).
Alert when audio quality is low: When selected Dragon displays audio quality alerts when dictation acoustic levels are poor, such as when your microphone is too far from your mouth or the battery is low, when background noise is too high, or when audio or dictation levels are too low or too high. Click the link provided in the alert/message window for troubleshooting or help information. 
Nuance recommends leaving this setting turned on to protect against adding dictation with low audio quality to your user profile.
Note: You can still save your User Profile if you receive any of these error messages, because Dragon excludes any low quality audio from adaption
[bookmark: _Toc320038456]Data Tab
Store corrections and archive: Enabled by default to ensure the corrections are stored for later use by Dragon's acoustic and language model Optimizer. Be sure to select this option when using Dragon NaturallySpeaking for an extended period of time. Select the Archive Size but to change the archive size.
Conserve disk space required by user files: instructs the software to maintain a smaller set of User Profiles so that you can more easily move them from computer to computer.
Incremental adaptation in additional training: Instructs the software to run the acoustic optimizer after user performs additional training using only the data gathered from the training session. If not selected, the software uses all data collected by the acoustic optimizer for adaptation.
Disk space reserved for playback: Adjusts the amount of disk cache space set aside for any overflow from your computer's memory of your actual dictation.
Save recorded dictation with document: Selection choices are, always which saves dictation files when you save a document without asking, ask you will prompt and expect an answer, never will not prompt or save dictation files.
Automatically back up user files every "n" saves: Adjusts how often your User Profiles are backed up automatically.
Run Accuracy Tuning Defined by Your Ministry: Select this to run Accuracy Tuning at the time defined by your administrator in the Scheduled Tasks tab of the Administrative Settings dialog box. Scheduled Accuracy Tuning will help Dragon learn from you and make your dictation more accurate.
Data collection: Select the Data Collection checkbox to enable Data Collection for this user profile. Nuance can use to enhance the accuracy of future versions of Dragon NaturallySpeaking.
Delete Data: Use this button to delete the Data Collection archive.
Advanced:
Click this button to open the Advanced dialog box and set the option to create a Creating Usability Log and Always Preserve Wave Data.
Create usability log: check this box to create usability log.
Always preserve wave data: Check so you can save dictation with Microsoft Word or DragonPad document if you selected "Always" or "Ask Me" from the "Save recorded dictation with document" list. There will not be any playback for text that was typed or pasted into a document, revised by typing, or moved around the document. If you want to preserve all your dictation independent of any changes made to the document, "Always preserve wave data".
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[bookmark: _Toc320038457]Chapter 4: Dragon Accuracy Center and Dragon Sidebar
[bookmark: _Toc320038458]Dragon Accuracy Center
The Accuracy Center offers a central location for tools you can use to personalize vocabulary, improve acoustics, find or manage commands, or get more information about improving accuracy. 
To open Accuracy Center, say "Open Accuracy Center" or click Help <Improve My Accuracy, on the DragonBar.
The Accuracy Center provides "one-stop shopping" for tools and information that can be used to ensure better recognition. 
Which tool to use first?
Click or say this link to open the Accuracy Assist, a tool that will help determine what needs  done to improve accuracy on your system or to resolve problems. 
1. Personalize your vocabulary 
Add a new word or phrase: say or click link to open, Add word or phrase dialog box.
Open the Vocabulary Editor: say or click link to open, the Vocabulary Editor dialog box, you can view or edit words, phrases and dictation commands, their pronunciations and properties such as capitalization, spelling, spacing,
Import a list of words or phrases: say or click link to open, Add Words from Documents dialog box.
Learn from specific documents: say or click link to open, Add Words from Documents dialog box. Will Let Dragon analyze for words that are often used and create a list of words that can be added to the user vocabulary.
Learn from sent e-mails: say or click link to open, Increase Accuracy from E-Mail dialog box.  Lets Dragon find and learn the names in your contact list.
2.  Set options and formatting
Open the Options dialog: say or click link to open, the Options dialog box. For detailed information on the Options dialog box see chapter 3.
Open the Auto Formatting options dialog, say or click link to open, the Auto-Formatting dialog box. For detailed information on auto formatting see chapter 2, page12
3. Adjust your acoustics
Check your microphone: click or say link to open Check Microphone dialog box and proceed as directed.
Launch Accuracy Tuning now: click or say link to open Acoustic and Language Model Optimizer dialog box, this feature can make a user profile more accurate by analyzing the dictation, corrections, and training that have been done since the last time this feature was used.  To schedule accuracy tuning to run periodically choose Administrative Settings from the Tools menu.
Read Text to Train Dragon to Your Voice: click or say link to open the General Training dialog box, and proceed as directed.
4. Find or train commands
Open the Command Browser: you can explore the various commands available in different contexts and applications, you can train commands to your voice, you can view exact command wording, this can be helpful when using Natural Language Commands.
 5. Get more information
How to manage and personalize your vocabularies: Dragon uses one or more vocabularies when creating a user profile to help it recognize words and phrases correctly based not only on the sound of the words and phrases, but also on their context. When a new user profile is created you select the vocabulary (the type and size). Dragon updates and adapts to your speech as you dictate. You can add vocabularies to existing profiles. When you have the Accuracy Center open you can Click on the link for more information about vocabularies.
Visit the Nuance website; for the latest tips and information.


[bookmark: _Toc320038459]The Dragon Sidebar
The Dragon Sidebar displays a selection of commands and tips available to the application or task that has focus on your screen. You can open the Dragon Sidebar by saying "What Can I Say" or "Open Dragon Sidebar".
The Dragon Sidebar has quick link symbols (from left to right), Command Browser, Vocabulary Editor, Dragon options, Sidebar help and close.
[image: ]
You can use the Dragon Sidebar to review examples of speech commands in your current program or task. The contents of the sidebar update automatically as you change applications.
The Sidebar displays tabs across the top, you can click on the tabs to view the most popular commands for your current task. The tabs include, Home tab, Global tab, Mouse tab and MyCommands tab.	
Home tab: use the home tab to review examples of voice commands for programs with Full Text Control. Below is an example of what you will see if you are working in Microsoft Word or Corel WordPerfect. If you are working in Microsoft Outlook you would seek Microsoft Outlook commands, for all programs with Full Text Control. For programs with Basic Text Control the Home tab displays a list of common dictation commands.
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Global tab: use the global tab will give you a list of Global Commands Available in Programs with Full Text Control.
Mouse tab: use the Mouse tab to review examples of common voice command you can use to control the mouse in your current application.
MyCommands tab: use the MyCommands tab to view custom command you have created.




[bookmark: _Toc320038460]Chapter 5: The Command Browser 
The Command Browser is a window where the user can locate Voice Commands that Dragon recognizes, including commands that are provided with the software as well as any custom commands that have been added. The Command Browser is the most comprehensive place to see the commands that are available in each application
You use the Command Browser to:
· View and train commands both global and application-specific commands
· Create and modify custom commands
· Import and Export commands
· Change the availability of custom commands
To open the Command Browser, go to Tools on the DragonBar, Command Browser. Or say, "Open the Command Browser" or "Start the Command Browser". You can also start the Command Browser from the Accuracy Center in the Help menu.
The Browser modes
[bookmark: _Toc320038461]Browse Mode: browse mode allows the user to search for specific commands. If the command exists, you can use the Command Browser to find it.
1. Use the list in the Context Box to select the application where the command or commands are that you are looking for.
2. Select the Include Global checkbox, by clicking it or saying " Include Global Commands"
3. Click or say "Keyword Filter" to display Keyword Filter dialog box.
4. Say or type a letter or word of the command you are looking for in the Choose Word box. If the letters/words exist, it is selected. If the letter or word does not appear, then there is no command in the current context that uses them.
5. Double-click on the word in the list or click or say “Add”, to add the word to the current list of Filter Words box.
6. If necessary, continue to enter words into the Choose Word box and add them to the Current list of Filter words box until you have added as much of the specific command as you can.
7. Click or say, "Done". The Command Browser displays the commands containing the words you entered, if commands containing all those words exist.
Example:
To see if there is a command that changes the font to bold in Microsoft Word 2010:
1. Select Microsoft Word 2010 from the Context list box.
2. Click or say "Keyword Filter"
3. Say or type the word "Bold" and then say "Add" or click the Add button to add it to the Current List of Filter Words box.
4. Say or type the word “Set" and then say "Add" or click the Add button to add to the Current List of Filter Words box.
5. Click or say, “Done".
The Command Browser displays all the commands that will turn text bold in Microsoft Word 2010.
Expanding commands in the Command Browser:
To expand a command
1. Open the Command Browser and if you are not already in browse mode, click or say, "Browse"
2. Select the command to expand.
3. Click or say one of the following buttons on the Command Browser task pane:
Optional: Expands optional statements. Optional statements are part of the command you do not have to say with the command to make it work, Optional statements appear in brackets: [ ]
Or: Expands Or statements, Or are used to indicate a number of alternative commands. Or statements are usually preceded or followed by other commands that are shown by a separator bar, I, usually enclosed by parentheses.
Ellipsis: Expands ellipsis. Ellipses indicate that more than one command can begin or end with a particular word. You can click the Ellipsis button multiple times to expand a complex command.
Show All: Shows just the current selection and expands the selection. The selection can resolve to a single command or a list of similar commands that you may need to refine further. Using Refine may be helpful if you have many displayed commands and want to look at only one. In many cases, clicking Refine will show you the commands you want.
[bookmark: _Toc320038462]Script Mode: Script mode allows the user to create new commands and select commands to delete, edit, copy, or preview. These features will be covered in the section, Creating Voice Commands on page 32.
You can expand each command by clicking the plus sign next to the command or by double-clicking the command name. The name of the command is what you say to execute that command. A variable in the command is shown in brackets < >.
A Command Preview window in which you may view the steps of a voice command can be accessed by saying "Preview" or by clicking on Preview. (or by pressing Control + P)
[bookmark: _Toc320038463]Manage Mode: Manage mode allows you to import, export, or edit the properties of selected custom commands. (Some of these functions are available in only Dragon Professional, Legal and Medical editions.)
Importing and Exporting commands
You can share custom commands with other users by exporting them to a file and then having the other user import that file.
Exporting Commands:  
1. Open the Command Browser by saying "Open Command Browser
2. Say "Manage" or click the Manage button, or press Control + X. 
3. Use the Group list to select the group containing the commands you want to export.
4.  4. Click the plus sign (+) to expand the list of commands that appear on your screen.  (You may need to do that in order to find the command you want to export.)
5. Select the checkbox to the left of any commands you want to export so that a check mark appears in it.
6. Say “Export” or click the Export button on the task pane. 
7. In the Export Commands dialog box, you can either
· Choose a File name for the ones listed, click Save, and then click either Overwrite, Merge, or Cancel on the Export Commands dialog box that appears. Overwrite replaces the commands in the existing file with the ones you selected. Merge adds the commands you selected to the ones already in the file.
· Enter new file name and click or say  ”Save”
Importing Commands
1. On the tools menu of the DragonBar, click Command Browser.
2. Say, "Manage" or click the Manage button, or press Control + I.
3. Say, "Import" or click the Import button in the task pane.
4. Use the "Import Commands" dialog box to select the location of the voice command file you want to import, then click Open
5. In the next Importing Commands dialog box, select the commands you want to import by selecting the box to the left of the command name. 
6. Say, "Import" or click the Import button in the task pane.
Change in the command group and availability
After checking the box to the left of the command name, say or click "Edit Properties" or press Control + E. The MyCommands properties dialog box will open.
The Availability defines where the command will be available:
· Global: The command will be available in every application.
· Application-specific: The command will be available in application you specify.
· Window-specific: The command will be available in the window you specify.


[bookmark: _Toc320038464]Voice Commands
You can create your own custom voice commands by using the MyCommands Editor. To access the MyCommands Editor, say, "Open Command Browser" or click on Tools >Command Browser or Add New Command, a custom voice commands let you automate repetitive tasks working in virtually any application. There are four types or methods of creating voice commands.
Text-and-Graphics: Text and graphics allow you to enter or paste text and graphics. A single voice command can then insert the Text-and-Graphics at your cursor location.
	Set the delimiting characters for the variable field.
You can also set the PowerMic or PowerMic II microphone buttons to navigate forward or backward from Voice (variable) Field to Voice Field
On the PowerMic I tab of the Options dialog box or the PowerMic II tab of the Options dialog box you can assign the buttons on of these actions:
Navigation > Select previous variable field.
Navigation> Select next variable field.
Macro Recorder: Macro recorder allows you to record a sequence of mouse movements and keystrokes. Likewise, this method is easy to learn but executes slowly.
Step-by-Step: Step-By-Step allows you to activate menu and keystroke commands one at a time. This method is easy to learn but executes slowly.
Advanced Scripting: Advanced Scripting uses programming languages such as Microsoft VBA to program commands. This is by far the more powerful method of creating voice commands.
The typical student should learn to create voice commands using the Text and Graphics, Step-by-Step, and/or Macro Recorder methods. Examples of Advanced Scripting are included in this manual; this method is more complex and is more appropriate for students with knowledge of programming languages. For students interested in learning Advanced Scripting there are many sources available. Larry V. Allen's, scripting for Dragon NaturallySpeaking Version 11 is a recommended source.
Hints for writing voice commands:
· Go through the steps using the keyboard first. Keyboard shortcuts for many  commercial and SSA applications are included as an appendix to this manual.
· Write each step down, including obvious wait times, while the computer processes information. (Such as the delay required to open PCOM)
· Use a name for the command that is unique as well is appropriate to the action. A three-word phrase is superior to a one-word command.
· Create the command, test it, modify if necessary.
· Maintain a list of all the voice commands, and what they do as you create them.
· For involve steps, create the voice command and phrases. Test each base before continuing to the next.
[bookmark: _Toc320038465]Creating New Commands
1. Type a name for your new command in the MyCommands Name field. This is what you will say to execute the command.
2. In naming the voice commands you should:
Use longer names for better recognition. The name you choose should easily be distinguished from dictation.
Do not begin commands with, dictation words such as "the" and "A".
Capitalize each command word (Except for minor words such as prepositions) so that when you give the command it will be easy for you to determine if Dragon understands the command as a command (it will be capitalized) or if Dragon understands it as text.
3. Type description for this command in the Description field.
4.  Select a group into which to place the command. You use these groups to locate the command in the Command Browser. By default, the groups Dragon and User-defined are available. Create your own group, select User-defined and type over it with the group name of your choosing. The new group name will appear in the list next time you create a command. If you plan on creating many commands, use group names that will make it easy for you to find and manage your commands.
5. Designate where the command will be available
Global: The command will be available in every application.
Application-specific: The command will be available in application you specify. When you select this option, the Application list appears. This list displays all the applications open on your system. If the application you want is not open, use the browse button to locate the application on your computer or open application as you would normally.
Window-specific: The command will be available on the window you specify. When you select this option, both the Application list and Window list appears. If the application window you want is not in the list, open the application and check the list again.
6. Use the Command Type List to Choose the Type of Command You Want.
[bookmark: _Toc238226308][bookmark: _Toc319678478][bookmark: _Toc319678765][bookmark: _Toc320038466]Creating Text and Graphics Commands
To create a Text and Graphics command, begin by following the steps in the "Creating new commands" section. Then follow the procedure described below.
1. In the Content box, supply the text, formatted text, bitmap, or combination of all three that this command will insert into a document. You can type or dictate plain text into the Content box and press keys such as Tab or Enter. To format text, use the formatting buttons underneath the Content box or a keyboard shortcut, such as Control + b for making text bold. You can also copy formatted text from another application. For bitmaps, create the bitmap in another application and paste it here.
1. [bookmark: 163]You can change the formatting of the text in the Content box with the formatting buttons below the Content box. To have the text in the Content box entered into documents with the same font style and size as the text preceding it in the document, select the Plain Text check box.
1. Click Save to save your new command.
[bookmark: _Toc238226309][bookmark: _Toc319678766][bookmark: _Toc320038467]Creating Step-by-Step Commands
To create a Step-by-Step command, begin by following the steps in the "Creating new commands" section. Then do the following:
1. Select Step-by-Step in the Command Type list.
1. Select a type of step from the list of the MyCommands Editor dialog box.
There are eight different types of steps:
Keystrokes - Acts as if you pressed a particular key.
Open (application) - Opens a particular application or document or switches to that application or document if it's already open.
Wait - Does nothing for a specified time.
Type Text - Types the text you specify.
[bookmark: 165]Send Keys - Types a sequence of keys including Control, Alt, and Shift key.
Stop Listening - Puts Dragon NaturallySpeaking into sleep mode.
Microphone On - Turns the microphone on.
Microphone Off - Turns the microphone off.
1. Select the type of step, then the Insert button. Depending on the type of step, Dragon NaturallySpeaking may ask you for more information. For example, for a Keystrokes step, you will be asked to enter the keystroke you want. Press the keystroke or dictate the keystroke using the "Press" command.
1. To edit a step, select the step you want edited, click or say “Edit”. To delete a step, select the step you want deleted and click or say “Delete”.
1. Click or Say “Save” to save your new command.
[bookmark: _Toc238226310][bookmark: _Toc319678767][bookmark: _Toc320038468]Using the Macro Recorder
To create a Macro Recorder command, begin by following the steps in the "Creating new commands" section. Then do the following:
1. Select the Macro Recorder from the Command Type list box.
1. Select the Record button. The underlying application, such as Microsoft Word, becomes the focus and a small button bar is placed at the bottom of the screen.
1. Enter any tasks you want to record. When you are finished, click on the stop button of the Macro toolbar.
1. Click the exit button in the Recorder title bar to return to MyCommands Editor.
1. Select the Save button.
[bookmark: _Toc238226311][bookmark: _Toc28699777][bookmark: _Toc8954487][bookmark: _Toc319678768][bookmark: _Toc320038469]Voice Command Examples
Example 1: Open Training Document
This is an example of a Step-by-Step command which will open a specific document in Microsoft Word.
1. Type, or dictate, “Open Training Document” in the MyCommand Name edit box. Type a description in the Description field. Type “Word” in the Group edit field (substitute Group name of your choosing). Select the Application Specific radio button. Select Microsoft Office Word from the Application combo box. Select Step-by-Step from the Command Type combo box.
1. Select Keystrokes from the New Step field and press the Insert button. Press “Control + o” in the Send Keystrokes edit box. Press Enter.
1. Select Send Keys from the New Step field and press the Insert button. Type “c:\dns7\training.doc” in the Send Keys Step edit field (substitute the drive, path, and file name for one of your choosing). Press Enter.
1. Select Keystrokes from the New Step field and press the Insert button. Press “Enter” in the Send Keystrokes edit box. Press Enter.
1. Select the Save button.

[image: ]

Example 2: Open Training Document 2
This is an example of a Step-by-Step command which will open Microsoft Word and a specific document.
1. Type, or dictate, “Open Training Document 2” in the MyCommand Name edit box. Type a description in the Description field. Type “Word” in the Group edit field (substitute Group name of your choosing). Select the Global radio button. Select Step-by-Step from the Command Type combo box.
1. Select Open (Application) from the New Step field and press the Insert button. Browse or type target: c:\Program Files\Microsoft Office\Office 11\Winword.exe
1. Tab to the Argument field. Type “c:\dns7\training.doc” in the arguments field (substitute the drive, path, and file name for one of your choosing). Press Enter.
1. If desired, tab to the Run field and select Maximized. Click OK.
1. Click Save.

[image: ]
Example 3: Using an Interactive Dialog Box
This is an example of a global advanced scripting command using a confirmation message box. The actual actions to be executed following the confirmation dialog box must be entered following the SendSystemKeys step. In the example below, the SendSystemKeys step clicks the Windows Start button.
1. Type, or dictate, command name (e.g. Practice Macro) in the MyCommand Name edit box. Type a description in the Description field. Select desired group in the Group edit field. Select the Global radio button. Select Advanced Scripting from the Command Type combo box.
1. Type the following steps in the Script editing window following the Sub Main entry:
	GoToSleep
	An optional step which puts Dragon to sleep.

	Begin Dialog UserDialog 400,98,"Start Button?" ' %GRID:10,7,1,1
	The commands to create a dialog box.
The “Start Button?” text is the dialog title and will be changed to appropriate text.
The “Click Windows Start Button?” text it the “what do you want to do” question.
If the user selects the Cancel button, nothing happens.
If the user selects the OK button the below action executes.

	Text 20,14,180,14,"Click Windows Start Button?",.Text1
	

	OKButton 70,63,90,21
	

	CancelButton 220,63,90,21
	

	End Dialog
	

	Dim dlg As UserDialog
	

	result = Dialog (dlg)
	

	If result = -1 Then ' If the user clicked OK,
	

	SendSystemKeys "{Ctrl+Esc}"
	The action if the user selects the OK button.

	End If
	


1. Click Save.
Example 4: Using a List of Choices 1
This is an example of an advanced script that uses a list to execute Windows commands. For example, you would say “Maximize Windows”. This type of voice command is more efficient than creating three separate commands.
1. Type, or dictate, command name (e.g. <SysMenu> Windows) in the MyCommand Name edit box. 
1. When the MyCommands Name Editor opens, finish typing the command name, if necessary, and then select “SysMenu” from the list and click the Edit button. 
1. In the List contents field, type the following items:
	%+{Space}n\Minimize
	Presses Alt +Spacebar, n to minimize the window when the user says Minimize Windows.

	%+{Space}r\Restore 
	Presses Alt +Spacebar, r to restore the window when the user says Restore Windows.

	%+{Space}x\Maximize 
	Presses Alt +Spacebar, x to maximize the window when the user says Maximize Windows.

	%+{f4}\Exit
	Presses Alt +f4 to exit the window when the user says Exit Windows.


1. Click OK to close the Insert List dialog box. Click OK to close the MyCommands Name Editor dialog box.
1. Type a description in the Description field. Select desired group in the Group edit field. Select the Global radio button. Select Advanced Scripting from the Command Type combo box.
1. Type the following in the Script editing window following the Sub Main entry:
SendKeys Mid(ListVar1, 1, InStr(ListVar1, "\")-1)
1. Click Save.
Example 5: Using a List of Choices 2
This is an example of an advanced script using a list. You say email followed by a name in the list.
1. Type, or dictate, command name (e.g., Email <fname>) in the MyCommand Name edit box. 
1. When the MyCommands Name Editor opens, finish typing the command name, if necessary, and then select “fname” from the list and click the Edit button. 
1. In the List contents field, type the following items:
r.favorite@comcast.net\Ralph
	sahippen@comcast.net\Sherri
	James Cady\Jay
	Lori Karl\Lori
The entry at the left of the backslash is what Dragon enters or executes; the entry to the right of the backslash is what you say.
Note: SSA employees are located in the Global list and therefore need only their correct “email” names; for non-SSA employees you must use their email addresses.
1. Click OK to close the Insert List dialog box. Click OK to close the MyCommands Name Editor dialog box.
1. Type a description in the Description field. Select desired group in the Group edit field. Select the Global radio button. Select Advanced Scripting from the Command Type combo box.
1. Type the following in the Script editing window following the Sub Main entry:
	SendKeys "^n"
	Presses Control + n to create a new email.

	SendKeys Mid(ListVar1, 1, InStr(ListVar1, "\")-1)
	Enters the email address of the selected person.

	Wait .5
	Pauses to let the computer catch up.

	SendKeys "{Tab 3}"
	Tabs to the Subject field.


1. Click Save.
Example 6: Inserting the List Voice Command Code
1. Create a Global Step-by-Step command named Insert List.
2. Select Type Text and enter the following text:
SendKeys Mid(ListVar1, 1, InStr(ListVar1, "\")-1)
3. Whenever you creating a list voice command, at the point in the script field requiring the  list code, say “Insert List”.
Example 7: Executing an Action Multiple Times 
This is an example of an advanced script using a list and “while” statements. The user will say, for example, ‘Tab x Times” where “x” is 1 through 9 (in this example).
1. Type, or dictate, command name (e.g., Tab <nrtx> Times) in the MyCommand Name edit box. 
1. When the MyCommands Name Editor opens, finish typing the command name, if necessary, and then select “nrtx” from the list and click the Edit button. 
1. In the List contents field, type the following items: [image: ]
1. Click or say “OK “to close the Insert List dialog box. Click or say “OK “to close the MyCommands Name Editor dialog box.
1. Type a description in the Description field. Select desired group in the Group edit field. Select the Global radio button. Select Advanced Scripting from the Command Type combo box.
1. Type the following in the Script editing window ABOVE the Sub Main statement:
 Dim NrT	    This declares a variable named “NrT”.
  Continue typing the following statements BELOW the Sub Main statement:
  Sub Main
	  NrT = 0  This states the variable named NrT is equal to zero

 While NrT < Val(ListVar1)  This means while the variable NrT is less than what you spoke,  			  then go to the next line

  SendKeys "{TAB}" The action line(s), the action is pressing the Tab key.  
 			  	
 NrT = NrT + 1 After the script presses the Tab key the counter is increased by  one. And the script continues repeating the action until the counter is no longer less than what you said.	
Wend	After the script presses the Tab key the counter is increased by one. And the script continues repeating the action until the counter is no longer less than what you said.
End Sub

1. Click or say "Save"
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Example 8: Inserting the Loop Command Code
Create a Global voice command named “Insert Loop” with the following script:
	SendKeys "{Up}{Home}{Enter}{Up}"
	SendKeys "Dim NrT"
	SendKeys "{Down 2}"
	SendKeys "NrT = 0{Enter}"
	SendKeys "While NrT < Val+9ListVar1+0{Enter}"
	SendKeys "'Place action steps here!{Enter}"
	SendKeys "NrT = NrT + 1{Enter}"
	SendKeys "Wend{Up 2}{Home}"
Whenever you are creating a voice command requiring a loop, at the point in the script field requiring the loop code, say “Insert Loop”. Finally, replace the line “SendKeys "'Place action steps here! {Enter}"” with the appropriate action.
Example 10: Get Mouse Position
This is an example of an advanced script, written by Larry V. Allen, which will locate your mouse position.
1. Type, or dictate, command name (e.g., Get Mouse Position) in the MyCommand Name edit box. Type a description in the Description field. Select desired group in the Group edit field. Select the Global radio button. Select Advanced Scripting from the Command Type combo box.
1. Type the following in the Script editing window:
Option Explicit
 Type RECT
Left As Long
Top As Long
Right As Long
Bottom As Long
End Type
Type POINTAPI
x As Long
y As Long
End Type
 ’declare Win32 API functions
 Declare Function GetCursorPos Lib "user32" _
 Alias "GetCursorPos" (lpPoint As POINTAPI) As Long
 Declare Function GetWindowRect Lib "user32" _
 Alias "GetWindowRect" (ByVal hwnd As Long, _
 lpRect As RECT) As Long
 Declare Function GetForegroundWindow& Lib "user32" ()
 Function GetWinCurPos(hwnd As Long) As POINTAPI
Dim pt As POINTAPI
Dim wRect As RECT
Dim result As POINTAPI
 GetCursorPos pt
 GetWindowRect hwnd, wRect
 result.x = pt.x - wRect.Left
result.y = pt.y - wRect.Top
 GetWinCurPos = result
End Function
 Sub Main
Dim hwnd As Long
Dim result As POINTAPI
Dim clip As String
 hwnd = GetForegroundWindow
result = GetWinCurPos(hwnd)
clip = "SetMousePosition 1," & result.x & _
"," & result.y
clip = clip & Chr(13) & Chr(10) & _
"ButtonClick" & Chr(13) & Chr(10)
'Clipboard clip
'MsgBox clip, 64, "Mouse Test"
End Sub
1. Click Save.
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[bookmark: _Toc320038470]Chapter 6: Using Dragon with Microsoft Outlook
Dragon provides a number of Natural Language Commands to use in Microsoft Outlook using these commands, you can avoid the multi-menu selection and mouse movement steps associated with the traditional Microsoft windows interface. Because the number of valid commands is so large and varied, you should just try saying what you want to do. If you get unexpected results, say "Undo That" to undo last action and try a different way to say the command.
Dragon Voice Shortcuts for Email and Calendar Commands: Located in the command options, Tools Menu, this checkbox enables Voice Shortcuts For E-Mail and Calendar that let you control Outlook's e-mail and calendar functions using commands that are pattered on your normal speech.
Note: before using e-mail and calendar shortcuts for the first time, you must run the Increase accuracy from e-mail tool, so that Dragon knows your Outlook contacts. Go to Help >Improve my accuracy >Learn from sent e-mails.
  Start Microsoft Outlook:
Say "Start Mail" or "Start Microsoft Outlook", you can also say "open", "launch",  "show".  For example, say "Show Microsoft Outlook"
Note: You can say, "E-Mail", " Message", "Memo" or "Mail" interchangeably in any of the e-mail command.
Checking for new e-mail:
To check for new mail, say "Go to Inbox" or "Check for new mail"
Opening and closing e-mail:
To open an e-mail message, selected and say, "Open Mail" or "Open That". To close the current e-mail message, say "Close Mail" (this command will not close your mail program).
Forwarding and Replying to E-Mails:
To reply to the sender of the current message, say, "Reply" or "Reply to Mail". Reply to everyone on the mailing list, Say, "Reply to All" and then move to the subject field and dictate your response. To forward the message, say, "Forward Mail", then dictate the recipient's address in the To Field of the new message and send.
Create an e-Mail message:
To create a new message, say "New Mail" or "New Message" or press control n. If the person you are e-mailing is in your contact list, you can say “Send E-mail to <persons name> .  Once the new blank message appears, you can navigate to any field by voice and start dictating. It will automatically populate that person’s e-mail in the To field. If it is a new contact  and not yet in your contact list, you can dictate the address as you would say it. (e.g.  Say, Carol underscore Lee at aol dot com to get Carol_Lee@aol.com)  
Sending and printing e-mail:
Once your message is ready to send, you can simply say," Send Mail ". To print a message, say "Print Mail" and the message will be sent to your printer.
Deleting e-mail:
You can delete the currently selected message by saying "Delete Mail". This command will work on all selected messages, so make sure you have selected only those you want to delete.
The following commands that you move around when editing e-mail:
"Go to To Field"
"Go to CC Field"
"Go to BCC Field"
"Go to Subject Field"
"Go to Body Field"
"Go to First Field"
"Go to Previous Field"
"Go to Last Field"
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[bookmark: _Toc320038471]Chapter 7: Using Dragon with Microsoft Word
Dragon NaturallySpeaking provides a special set of Natural Language Commands for use with Microsoft Word:
· You can create a new document, open an existing document, or close the document.
· You can move the text insertion point around the document.
· You can format text: changing text fonts and styles, setting colors, applying paragraph styles, adding tables, setting margins and inserting new lines and paragraphs
· You can run spelling and grammar checks.
· You can edit text by moving, copying, pasting and deleting text.
· You can print all or part of a document and print preview your work
[bookmark: _Toc320038472]Composing Natural Language Commands
The Natural Language Commands available in Microsoft Word can improve productivity by providing voice commands that will shortcut many operations. For example, you can move specified text to a new location with a single sentence voice command. "Move the Next Paragraph to the End of the Document." This means you no longer need to perform the multi-menu-selection and mouse-movements associated with the traditional Microsoft Word interface.
Because the number of valid Natural Language Commands is very large it isn't practical to list them all here. Instead compose your own Natural Language Commands using the ones listed below as a pattern for commands. Then try saying what you want to do. If you get an unexpected result simply say "Undo That" to undo the action. 
To Change Font Size: say "Set the Font to 18 Points in the word/line/paragraph" Or "Change the Font to 14 Points" or "Increase/Decrease the Font Size to 18 Points in the Word/Line/Paragraph"
To Change Text Properties: say "Underline This Word/Line/Paragraph" or "Bold This Page" or "Italicize Next <number >Words". Say “Bullet this Line”, or “Bold this Paragraph.
To Change the Line Spacing: say "Double space the last Paragraph" or "Increase Paragraph Spacing to <number >inches/centimeters"
To Change Margins: say "Change the Top Margin to an Inch and a Half" or "set the left margin to 2 inches".
To Delete Text: say "Delete the Last Five Rows" or "Delete the Next Two Paragraphs".
To Capitalize Text: say "Make the Last Paragraph Uppercase" or "Make this Sentence Capitalized"
To Change Capitalization: say, “Capitalize the First/Last/Next Word/Line” “Capitalize the First/Last/Next<Number>Words/Lines/Paragraphs" for example "Capitalize the Next Five Words" or "Lowercase the Last 10 Words"
[bookmark: _Toc320038473] Voice commands for Word
You can use the following voice commands to perform basic document operations using Microsoft Word.
Creating, opening, and closing a document
	Say
	To

	“Create New File” or “Open the File”
	Create new document  in Microsoft Word 

	“Open File” or “<file name>dot<File extension>”, 
For ex: My Document dot doc
	Open an Existing Document you have saved 

	“Close File” or “Close Document”
	Close the document 



Saving a document
	Say
	To

	1.”Save changes"
2. Dictate a file name (only needed 
 if this is the first time the file 
 has been saved)
3. "Click Save”
	Save the document as a.doc file

	1. "Save document as"
2. "Dictate a file name" 
3. "File type <file type from list >" 
 ex; RTF 
4. "Click save" 
	Save a document with new file name and file type

	1. "Save document as webpage" 
2. "Click save" 
3. If a dialog box appears warning of a text format,  "Click Continue"
	Save a document in HTML format

	1. "Save the page setting as default"
	Save as document template





Page setup
	Say
	To

	"Set page orientation to landscape"
"Set page orientation to portrait"
	Set the page orientation


	"Set top/bottom margin to <number
  inches/centimeters " ex: " Set bottom  margin to 2 inches "
	Set margins

	"Add page numbers"
"Create page numbers"
	Number pages

	1. "Go to header/footer"
2. Dictate text to appear in the header or footer 
3. "Close header/footer"
	Create headers and footers

	1. "Go to <location >" (to move the insertion point to the location where you want to place information)
2. "Insert date time" or "Insert date"
 "Insert time"
	Add the date and time



Spelling and grammar check
	"Check spelling" simply say the name on the button depending on how you want to respond "Ignore All", "Change"
etc. then "Close”  

	Check spelling

	"Check grammar" simply say the name of the button depending on how you want to respond "Ignore", "Change" etc
Then "close"
	Check grammar



Quick Voice Formatting
There are now new direct commands for formatting your text. Rather than selecting specific text and then giving a command. (e.g.; "select extremely, [pause], underline that"), with quick voice formatting you can complete the action in one single command (ex; "underline extremely").





EWD IWS/LAN Workstation – Trainers Guide
Chapter 7: Using Dragon with Microsoft Word

[bookmark: _Toc320038474]Chapter 8: Using Dragon with Internet Explorer
Dragon offers voice shortcuts for Web searches. This must be enabled in the Tools menu, under options, command tab. This checkbox enables web search commands that let you search the Internet using commands that are patterned on your natural speech.
Your web browser does not have to be open when you use a Voice Shortcut command; Dragon recognizes when you use the Voice Shortcut command and opens your default browser for you.
	Say
	To

	“Search the web <subject >”
	Open the browser and search the web


	“Search <website >for <subject >”
	Open the browser and search specific websites


	“Search <category >for <subject >”
	Open browser and display the search results you requested

	“Find the website about/on/for <subject >”
	Open browser and display Google's top ranked pages for the phrase ("I'm feeling lucky")



[bookmark: _Toc320038475]Navigating around Internet Explorer 
You can use voice commands to:
· Go to any site on the favorites menu
· Go to and enter a web address in the address bar
· Go to the previous webpage or forward to the next page
· Scroll up or down in a Web page
· Move between Frames on a Web page 
Summary of Navigation Commands
	Say
	To

	"Go to Address Bar"
	Move the insertion point to the Address box

	"Click Go " or "Press Enter"
	Go to the Web address in the Address box 

	"Go Back"
	Go back to the previous Web page

	"Go Forward"
	Go forward to the next Web page

	"Stop Loading"
	Stop a Web page from loading

	"Refresh Page" or "Reload Page"
	Refresh the current Web page

	"Next Frame"
	Move to next frame on Web page

	"Previous Frame"
	Move to previous frame on Web page

	"Go Home"
	Go to your Homepage

	"Go to Bottom"
	Scroll to the end of the page

	"Go to Top"
	Scroll to the beginning of the page

	"Page Down"
	Scroll down one screen

	"Page Up"
	Scroll up one screen

	"Line Down"
	Scroll down one line

	“Line Up”
	Scroll up one line

	"Start Scrolling Down"
	Start automatic scrolling toward the end of the page

	"Start Scrolling Up"
	Start automatic scrolling toward the beginning in an age

	"Speed Up"
	Increase scrolling speed

	"Slow Down"
	Decrease scrolling speed

	"Stop Scrolling"
	Stop automatic scrolling



As seen in the Commands Option Tab (Tools menu)
Enable HTML support: Allows you to enable commands in HTML windows and allows you to choose whether or not you're required to "click" to select hyperlinks in HTML windows.
Enable commands in HTML Windows: Checking this allows the use of commands designed specifically for use with Internet Explorer. Any change to this option does not take effect until you restart Dragon NaturallySpeaking and then started Internet Explorer.
Require "Click" to select hyperlinks and HTML windows: If you select this check box you are required to speak the word "click to select a hyperlink. By default, this feature is turned off for Internet Explorer.
Enabling and disabling HTML support. (As seen above) Enables commands in HTML windows.  Allows the use of commands designed specifically for use with web browsers such as Internet Explorer.
[bookmark: _Toc320038476]Selecting  and Working with Links, Images, Boxes and Buttons 
On a Web page Dragon allows you to select which Edit box, List box, Image, Checkbox, Radio Button or link you want to go to. On a Web page you can go to and edit any text box visible on your screen. 


Links
You can click the text links and buttons simply by saying the link or button name. If the text link or button name is long, you don't need to say all of it. Just say enough to distinguish it from other links on the page. If more than one link matches what you said Dragon NaturallySpeaking numbers all the links on the page. Say "Choose" plus the number of the link you want. For example, say "Choose 2".
You can also say "Click" and in the link text. Sometimes saying "Click" first is more reliable than just saying the link text alone.
Note: On secure Web pages this feature is disabled. You cannot select links on a secure page by voice.
Text Boxes 
Say "Type Text" to move to the first text box on the page. Or you may also say "Edit Box" or "Text Field” In some cases you can just say the name of the Edit box. 
If the page has more than one text box, they will be numbered. Choose the number you want, or move to the next or previous text box by saying "Next" or "Previous".
You can use many of the Dragon commands when you are dictating in a text box.
[bookmark: _Toc319678769][bookmark: _Toc319745833][bookmark: _Toc320038477]Check boxes or Radio buttons 
[bookmark: _Toc319678770][bookmark: _Toc319744467][bookmark: _Toc319745834][bookmark: _Toc319678771][bookmark: _Toc319744468][bookmark: _Toc319745835]In some cases, you can just say the name of checkbox or option button. If there is more than one you can say ”Check box” or Radio button” depending on what you want.
If the page has more than one option or box,  Dragon will number them and take you to the first one. Choose the number you want. For example "Choose 2". You can also say "Click" followed by all or part of the name label. If this does not work, say “Click Check Box” or “Click Radio Button” 
[bookmark: _Toc319744469][bookmark: _Toc319745836][bookmark: _Toc320038478] List boxes
[bookmark: _Toc319744470][bookmark: _Toc319745837]Again, with list boxes you can just say the name of the list box, or "List Box" or "Click List Box". 
[bookmark: _Toc319678774][bookmark: _Toc319744471][bookmark: _Toc319745838]If there is more than one on the page, Dragon will number them and take you to the first one.
[bookmark: _Toc319678775][bookmark: _Toc319744472][bookmark: _Toc319745839][bookmark: _Toc319744473]To open the list, say, "Drop List" or "Show Choices". To make a selection from an open list say the full name of the selection. Or say "Move Down" or "Move Up" in the number of places your selection is from the current selection. When the selection you want is highlighted, say "Hide Choice "or" Enter".
[bookmark: _Toc320038479]Working with multiple links, boxes and button
If more than one text box, list box, check box, or option button matches what you said, a series of numbered markers appear next to the possible matches.
A red marker points to Dragon's first choice. This is the choice that it will select if you say "Click That," "That One," or "Click That One."
Green markers point to additional choices. Say "Choose" and the number of the marker next to the list you want to open, or simply say the number.
You can say "Hide Numbers" to hide the number indicators.
The following table is a list of commands you can use for clicking links, images, check boxes, lists and button
	What to Say
	What It Does

	"Type Text" or "Edit Box"
	Numbers all Text boxes on page and goes to the first one

	"Check Box" or "Click Check Box"
	Numbers all check boxes on the page and goes to the first one

	"Image"
	Numbers all images links on the page and goes to the first one

	"Radio Button" or "Click Radio Button"
	Numbers all option (radio) buttons on the page and goes to the first one

	"List Box" or "Click List Box"
	Numbers all boxes with list of choices on the page and goes to the first one

	"Show Choices"
	Opens a list of choices

	"Hide Choice"
	Closes a list of choices

	"Choose " and the number to what you want
	Selects the image, option, but and so on from the numbered list of choices. You can say any number that appears
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[bookmark: _Toc190099234][bookmark: _Toc190102311][bookmark: _Toc190102747][bookmark: _Toc190103008][bookmark: _Toc190103527][bookmark: _Toc319001830][bookmark: _Toc320038480]Chapter 9: Dragon hints for SSA applications:
[bookmark: _Toc320038481]PCOM
PCOM is used, to a greater or lesser extent, by most SSA employees.  In brief, PCOM is a program which interacts with the Social Security database, allowing the user to access information for anyone holding a Social Security Number.  PCOM is also used to input and modify this data, to input and modify claims for retirement and disability, and to exchange information between Teleservice Centers and Field Offices.  In addition, Payment Centers use PCOM to process payments.  PCOM is frequently used in conjunction with other SSA programs (e.g., WebCHIP).
There are some issues when trying to use Dragon NaturallySpeaking in PCOM. Dragon NaturallySpeaking is a phrase and sentence program; PCOM’s data entry is in short fields requiring single numbers or letters making it difficult to dictate with accuracy.
 There are a few methods to use when working in PCOM; 
· Switching into Spell Mode, allows the user to speak letters, numbers and commands.  You do not need to say numeral and the number or type and the letter, just the number or letter.  
· In the Tools Menu under Auto Formatting Options, then in the  Numbers, if greater than or equal to ‘n’: put a zero to force Dragon to inserts numbers as numerals if they are equal to or greater than the value shown in the drop-down list. If the number is less than the chosen value, the number is spelled out. This is a great option for user who does not want to switch modes.
· Using custom macros created for individual users to do specific tasks is another option.
PCOM formatting moves the cursor from field to field automatically as the current field is filled. This causes an empty space to be added as you dictate into the next field. The user needs to say “No Space” or “Back Space one”, then begin dictation.
[bookmark: _Toc320038482]EVIEW
The Case Document Screen in Eview does not respond to HTML voice commands (e.g. links, checkbox etc.). You can use the press key commands (e.g. press Alt. D) to activate some links.
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[bookmark: _Toc320038483]Appendix A - Dragon NaturallySpeaking Command Summary:
[bookmark: _Toc320038484]  Controlling the Microphone
	Say
	To

	“Go to Sleep”  or  “Stop Listening”
	Make the microphone stop listening

	“Wake Up”  or  “Listen to Me”
	Reactivate the microphone when it is sleeping

	“Microphone Off”
	Turns the microphone off. (You cannot turn it back on by voice)



[bookmark: _Toc320038485]  Controlling the DragonBar
	Say
	To

	"Give Me Help"
	Opens the Dragon NaturallySpeaking online help

	"Open Dragon Sidebar" or " What Can I Say" 
	Opens the Dragon Sidebar displays list of commands available in current application

	"Save User Profile
	To save your user profile

	"Select Tray Icon Only Mode""
	Will hide DragonBar Restore it by clicking on the microphone icon in the system tray located in the lower right of your computer screen. Choose restore Dragon bar mode.

	"Manage User Profiles"
	Opens the manage user profile dialog box

	"Train My User"
	Opens the general training dialog box

	"Check Audio"
	Opens a check microphone dialog box

	"Open Accuracy Assistant" 
	Opens the Accuracy Assistant window

	"Open Accuracy Center"
	Opens Accuracy Center window 

	"Start DragonPad" or “ Open DragonPad"
	Opens the DragonPad word processor

	"Open Command Browser" or "Start Command  Browser"  
	Opens the Command Browser

	"Add a Command or Create Command"
	Opens MyCommands Editor

	"Edit Vocabulary" or "Open Vocabulary Editor"
	Opens the Vocabulary Editor

	"Give Me Help"
	Opens Dragon online help

	"Close NaturallySpeaking"
	Will exit the Dragon NaturallySpeaking program





[bookmark: _Toc320038486]  Controlling the DragonPad
	Say
	To

	"Save Document"
	Save the current document

	"Save File As"
	Save the current document in a different location or using a different name

	"Print Document"
	Print the current document

	"Start Playback"
	Have your dictation played back to you

	"Find Text"
	Opens the find feature dialog box

	"Quit DragonPad" 
	Exit the DragonPad



[bookmark: _Toc320038487] Selecting Icons on the Desktop
	Say
	To

	"Move" followed by a direction and the number of icons you want to move. (Desktop must be active) then press " Enter"
	Select an icon and open

	“The name of the icon”, then press " Enter"
	Select an icon and open


[bookmark: _Toc320038488] Opening and Closing Menus
	Say
	To

	"Click <tab on menu ribbon >" or "<Name >" such as “Click Insert"  or "Insert"
	To open or activate a menu

	"Cancel"
	Close an open menu


[bookmark: _Toc320038489]  Selecting Buttons, Tabs, and Options
	Say
	To

	“Click OK" or "OK"
	Activate a button, in this example OK

	"Click Miscellaneous" or "Miscellaneous"
	Activated tab in a tabbed dialog box, in this example, the Miscellaneous tab

	"Go to Next Tab" or "Move to Next Tab" or "Click Next Tab" or "Next Tab"
	Moves to next tab in tabbed dialog box

	"Go to Previous Tab" or "Move to Previous Tab" or "Click Previous Tab" or "Previous Tab"
	Moves to previous tab in a tabbed dialog box



[bookmark: _Toc320038490]Start a program or switch between applications
	Say
	Then say
	To

	 "Start" or "Open"
	Then say the name on the Start menu or Icon
	Start the application

	"Click Start"
	Then say the name that is on the start menu
	Access the start menu

	"List all Windows" or "List Applications" or " List Programs"
	Then choose the number next to the application you want
	Switch to a different program or application

	"Switch to<application name>
	then say the exact name 
	Switch to a different application that is open

	"Switch to Previous Window"
	
	Switch to previous window (equivalent to pressing Alt + Tab)

	"Switch to Next Window"
	
	Which to next window (equivalent to pressing Alt + Shift+Tab)



[bookmark: _Toc320038491] Resizing and closing windows
	Say
	To

	"Click Maximize" or "Maximize Window" 
	maximize the active window

	"Click Minimize" or "Minimize Window"
	minimize the active window

	"Click Restore" or "Restore Window"
	restore the active window to its previous size

	"Click Control Menu"
	open the Control menu for the active window



[bookmark: _Toc320038492] Correcting Text
	Say
	To

	"Select Document" or "Select All"
	Selects all the text in your document

	"Select <text >
	Selects the text you specify and displays the Correction menu

	"Select That" or "Correct That"
	Selects the last dictation and displays Correction menu

	"Spell"
	Opens up Spelling Window dialog box so you can spell the word before dictating it

	"Spell That"
	Opens up Spelling Window dialog box 





[bookmark: _Toc320038493]Adding Lines and Spaces
	Say
	To

	"New Line"
	presses the enter key once

	"New Paragraph"
	presses the enter key twice and capitalizes the next word

	"Tab Key"
	presses the tab key

	"Space Bar "
	presses the  space bar

	"No Space"
	does not put a space before the next word

	"No Space on"
	stops putting spaces between words

	"No Space Off"
	starts putting spaces between words



[bookmark: _Toc320038494]Selecting Text
	Say
	Then Say
	Then Say

	“Select”
	“Next” 
“Last”
“Previous”
	“Character”
“2 to 20 Characters”
“Word”
“2 to 20 Words”
“Line”
“2 to 20 Lines”
“Paragraphs”

	“Select”
	“Word”
“Line”
“Paragraph”
	



[bookmark: _Toc320038495]Deleting Characters, Words, Lines, or Paragraphs
	Say
	Then Say
	Then Say

	“Delete”
	“Next”
“Last’
“Previous”
	“Character”
“2 to 20 Characters”
“Word”
“2 to 20 Words”
“Line”
“2 to 20 Lines”
“Paragraphs”





[bookmark: _Toc320038496]Erasing and Undoing
	Say
	To


	“Delete That”
	Press the Delete Key


	“Backspace”
	Press the Backspace key
 

	“Backspace <#>”
	Press the Backspace key from 2 to 20 times


	“Undo That”
	Undo the last action, including the actions of many commands

	“Scratch That” 
	Erase what you just said




[bookmark: _Toc320038497]  Moving around in a Document
	Say
	Then say

	“ Go To “ or “Move to”
	“Top” or  “Bottom”
“Beginning of Line”  or  “End Of Line’



[bookmark: _Toc320038498] Moving Around by Lines or Paragraphs
	Say
	Then Say
	Then Say

	“Move”
	“up” or “Down”
“Forward” or “Back”

	“1  Line” or  “1 Paragraph”
“2 to 20 Lines” or “2 to 20 Paragraphs”



[bookmark: _Toc320038499] Moving Around by Words or Characters
	Say
	Then say
	Then say

	“Move”
	“Right” or “Left”
 “Forward” or  “Back”
	“1 Word” or  “1 Character”
“2 to 20 Words” or “2 to 20 Characters”


[bookmark: _Toc8954473][bookmark: _Toc238226346]
[bookmark: _Toc320038500] Capitalizing Text
	Say
	To

	"Cap word”
	Start the next word with a capital

	"Caps On"
	Start typing words with initial capitals

	"Caps Off"
	Stop typing words with initial capitals

	"All-Caps word"
	Type the next word in all uppercase

	"All-Caps On"
	Start typing words in all uppercase

	"All-Caps Off"
	Stop typing words in all uppercase

	"No-Caps word"
	Type the next word in all lowercase

	"No-Caps On"
	Start typing words in all lowercase

	"No-Caps Off"
	Stop typing words in all lowercase

	"Cap That"
	Capitalize the first letter of each word

	"All-Caps That"
	Apply all uppercase

	"No-Caps That"
	Apply all lowercase



[bookmark: _Toc320038501] Moving the Insertion Point to Before or After a Specific Word
	Say
	To

	“Insert Before glass”
	Move the insertion point before a specific word or words that are visible on the screen. e.g., the insertion point is placed before glass.

	“Insert After glass”
	Move the insertion point after a specific word or words that are visible on screen. e.g., the insertion point is placed after glass.

	“Insert Before That”
	Move the insertion point before selected text that is visible on screen.

	“Insert After That”
	Move the insertion point after selected text that is visible on screen.



[bookmark: _Toc320038502] Copy, Cut, and Paste
	Say
	To

	“Copy Selection”
	Copy selected text to the Clipboard.

	“Cut Selection”
	Cut selected text.

	“Copy That”
	Copy the selected text to the Clipboard.

	“Cut That”
	Cut the selected text.

	Paste That”
	Paste the contents of the Clipboard.

	“Copy All to Clipboard”
	Copy all the text in your document to the Clipboard.


[bookmark: _Toc320038503]Hyphenate or Compound Text
	Say
	To

	“Hyphenate That”
	Hyphenate either the last thing you said or the selected text.

	“Format That With Hyphens”
	Hyphenate the selected text.

	“Compound That”
	Compound either the last thing you said or the selected text.

	“Format That Without Spaces”
	Compound the selected text.



[bookmark: _Toc320038504]  Formatting Text
	Say
	To

	“Bold That”
	Apply bold to the selected text.

	“Italicize That”
	Apply italics to the selected text.

	“Bold Italicize That”
	Apply bold and italics to the selected text.

	“Underline That”
	Apply underlining to the selected text.

	“Restore That” or “ Format That Plain” or “Format That Normal” or  ” Format That Regular”
	Remove formatting from the selected text.



[bookmark: _Toc320038505] Move the Mouse Pointer
	Say
	Then say
	Then say

	"Mouse"
	"Up" or "Down"
"Left"  or "Right"
	Any number between "1" and "10"



	Say
	To
	Then say

	"MouseGrid"
	Place the MouseGrid over the full screen 
	Number between 1 and 10

	"MouseGrid Window"
	Place the MouseGrid over the active window
	Any number between "1" and "10"

	"Go"
	Close MouseGrid automatically and end the MouseGrid command
	

	"Cancel."
	To close MouseGrid
	



[bookmark: _Toc320038506] Microsoft Internet Explorer Command Summary
 Navigating the Web
	Say
	To

	“Go to Address”
	Move to the Address box.

	“Click Go” or 
“Go There”
	Go to the Web page specified in the Address box.

	“Refresh” or  “Reload”
	Refresh the current Web page.

	"Click <button>“or say the button name or part of the button name.
“Click <Image> or say the text next to the Image.
	Where the button/Image represents the text shown on the page. If there are multiple buttons/Images with similar names, Dragon displays a number next to each button or image. (e.g. “2” Next, you say the number of the button you want to click. A red arrow appears and Dragon activates the button or Image. 

	“Click” <link text> e.g.” Contact Us”  or 
Say the link text “Contact Us”
	Follow the link that is a word or phrase, in this example, Contact Us. If there are links with similar names, Dragon displays a number next to each links. (e.g. “2” Next, you say the number of the link you want to click. A red arrow appears and Dragon activates the link.

	“Next Match” or ” Next”
	Select the next matching link or object on the page.

	“Previous Match” or  “Previous”
	Select the previous matching link or object on the page.

	“Click That” or  “That One”
	Click the selected link, edit box, and so on.

	“Stop Loading”
	Stop loading a Web page.

	“Go Back”
	Go to the previous page.

	“Go Forward”
	Go to the next page

	“Go Home”
	Go to your home page.



 Navigating around a Web Page
	Say
	To

	“Go to Bottom”
	Displays the bottom of the current page

	“Go to Top”
	 Displays the top of the current page

	“Page Down”
	Move the page down one screen.

	“Page Up”
	Moves the page up one screen.

	“Line Down”
	Moves the page down by a few lines of text.

	“Line Up”
	Moves the page up by a few lines of text.

	“Start Scrolling Down”
	Start automatic scrolling toward the end of the page.

	“Start Scrolling Up”
	Start automatic scrolling toward the beginning of the page.

	“Speed Up” or “ Scroll Faster”
	Increase scrolling speed.

	“Slow Down” or Scroll Slower”
	Decrease scrolling speed.

	“Stop Scrolling”
	Stop automatic scrolling.

	“Next Frame”
	Moves to the next frame in a multiframe page

	“Previous Frame”
	Moves to the previous frame in a multiframe page

	“Next Pane”
	Moves to the next pane in a multipane page

	“Previous Pane”
	Moves to the previous pane in a multipane page



[bookmark: _Toc320038507] Working with forms
	Say
	To

	Type Text or Edit Box or
 say “<the name of the box>”
	Moves to the first one on the page, If more than one matches what you said a number will appear next to the possible matches. Choose the one you want.

	Click Check Box” or ” Check Box” or say “<the name of the box>”
	Moves to the first one on the page, If more than one matches what you said, a number will appear next to the possible matches. Choose the one you want.

	“Click Image” or “Image” or say “<the name of the Image>”
	Moves to the first one on the page, If more than one matches what you said, a number will appear next to the possible matches. Choose the one you want


	“Click Radio Button” or ”Radio Button” or say “<the name of the Image>”
	Moves to the first one on the page, If more than one matches what you said a number will appear next to the possible matches. Choose the one you want.

	“Click List Box” or ” List Box” or say “<the name of the box>”
	Moves to the first one on the page, If more than one matches what you said a number will appear next to the possible matches. Choose the one you want.

	“Show Choices”
	Open a list of choices.

	“Hide Choices”
	Close a list of choices.

	“Show Choices” or “Drop List” or “Open List”
	Opens the list box to show all the choices available in the list.



[bookmark: _Toc315166632][bookmark: _Toc320038508]Phonetic Alphabet
	[bookmark: _Hlk309029176]  To  Type:
	Say, "press…"

	A
	"alpha"

	B
	"bravo"

	C
	"Charlie"

	D
	"delta"

	E
	"echo"

	 F
	"foxtrot"

	G
	"golf"

	H
	"hotel"

	I
	"India"

	J
	"Juliet"

	K
	"kilo"

	L
	"lima"

	M
	"Mike"

	N
	"November"

	O
	"Oscar"

	P
	"papa"

	Q
	"Quebec"

	R
	"Romeo"

	S
	"sierra"

	T
	"tango"

	U
	"uniform"

	V
	"Victor"

	W
	"whiskey"

	X
	"x-ray"

	Y
	"Yankee"

	Z
	"Zulu"


[bookmark: _Toc238226338][bookmark: _Toc320038509]Entering Punctuation and Symbols
	
To
enter
	Say
	To
enter
	Say

	&
	Ampersand
	*
	Asterisk

	’
	Apostrophe
	’s
	apostrophe ess

	@
	at sign
	`
	back quote

	'
	begin single quote
open single quote
	'
	close single quote
end single quote

	"
	open quote
begin quote
	"
	close quote
end quote

	\
	Backslash
	/
	forward slash
slash

	:
	Colon
	:
	numeric colon

	,
	Comma
	,
	numeric comma

	^
	Caret
	©
	copyright sign

	--
	Dash
	°
	degree sign

	.
	dot
point
	.
	Period

	$
	dollar sign
	…
	Ellipsis

	=
	equal sign
	|
	vertical bar

	!
	exclamation point
	-
	hyphen
numeric hyphen

	{
	left brace
open brace
	}
	close brace
right brace

	[
	left bracket
open bracket
	]
	right bracket
close bracket

	(
	left parenthesis
open parenthesis
	)
	right parenthesis
close parenthesis

	<
	left angle bracket
open angle bracket
	<
	less than

	>
	right angle bracket
close angle bracket
	>
	greater than

	-
	minus sign
	#
	pound sign
number sign

	%
	percent sign
	+
	plus sign

	£
	Pound sterling sign
	?
	question mark

	
	registered sign
	§
	section sign

	;
	Semicolon
	(space)
	space bar

	(tab) 
	tab key
	~
	Tilde

	_
	Underscore
	;-)
	winky face

	:-(
	frowny face
	:-)
	smiley face
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[bookmark: _Toc238226353][bookmark: _Toc320038510]Appendix B- Sample Keyboard Commands
[bookmark: _Toc320038511] Word Keyboard Commands
	[bookmark: _Toc406158917][bookmark: _Toc414364982][bookmark: _Toc428019288][bookmark: _Toc428031940]Characters
	

	Control + Shift + F 
	Change the font

	Control + Shift + P 
	Change the font size

	Shift + F3
	Change the case of letters

	Control + Shift + A 
	Format letters as all capitals

	Control + B 
	Apply or remove bold formatting

	Control + U 
	Apply or remove an underline

	Control + Shift + W 
	Underline single words

	Control + I 
	Apply italic formatting

	Control + Shift + K 
	Format letters as small capitals

	Control + Shift + Z 
	Remove formatting (plain text)

	[bookmark: _Toc406158918][bookmark: _Toc414364983][bookmark: _Toc428019289][bookmark: _Toc428031941]Paragraphs
	

	Control + E 
	Center a paragraph

	Control + J 
	Justify a paragraph

	Control + I 
	Left align a paragraph

	Control + R 
	Right align a paragraph

	Control + M 
	Indent a paragraph from the left

	Control + Shift + M 
	Remove a paragraph indent

	Control + Q 
	Remove paragraph formatting

	Control + Shift + S 
	Apply a style (with the Formatting toolbar displayed)

	[bookmark: _Toc406158919][bookmark: _Toc414364984][bookmark: _Toc428019290][bookmark: _Toc428031942]Insert Special Characters
	

	Shift + Enter 
	Line break

	Control + Enter 
	Page break

	Control + Shift + Enter 
	Column break

	Control + Hyphen 
	Optional hyphen

	[bookmark: _Toc406158920][bookmark: _Toc414364985][bookmark: _Toc428019291][bookmark: _Toc428031943]Print a Document
	

	Control + P 
	Print command (File menu)

	[bookmark: _Toc406158921][bookmark: _Toc414364986][bookmark: _Toc428019292][bookmark: _Toc428031944]Insert Fields
	

	Alt + Shift + D 
	Date field

	Alt + Shift + P 
	Page field

	Alt + Shift + T 
	Time field

	Control + G 
	Go To Command

	[bookmark: _Toc37559995][bookmark: _Toc37559996]Edit and Move Text
	

	Control + C 
	Copy text or graphics

	Control + Shift + C 
	Copy formats

	Control + V 
	Paste text or graphics

	Control + Shift + V 
	Paste formats

	Control + X 
	Move text

	[bookmark: _Toc406158913][bookmark: _Toc414364978][bookmark: _Toc415501416]Delete Text and Graphics
	

	Backspace 
	Delete one character to the left

	Control + Backspace 
	Delete one word to the left

	Delete 
	Delete one character to the right

	Control + Delete 
	Delete one word to the right

	Control + X 
	Cut selected text to the Clipboard

	Control + Z 
	Undo the last action

	[bookmark: _Toc406158914][bookmark: _Toc414364979][bookmark: _Toc415501417]Select Text and Graphics
	

	Shift + Right Arrow 
	One character to the right

	Shift + Left Arrow 
	One character to the left

	Control + Shift + Right Arrow 
	To the end of the word

	Control + Shift + Left Arrow 
	To the beginning of a word

	Shift + End 
	To the end of a line

	Shift + Home 
	To the beginning of a line

	Shift + Down Arrow 
	One line Down

	Shift + Up Arrow 
	One line Up

	Control + Shift + Down Arrow 
	To the end of a paragraph

	Control + Shift + Up Arrow 
	To the beginning of a paragraph

	Shift + Page Down 
	One screen Down

	Shift + Page Up 
	One screen Up

	Control + Shift + End 
	To the end of a document

	Control + Shift + Home 
	To the beginning of a document

	Control + A 
	To include the entire document

	[bookmark: _Toc406158915][bookmark: _Toc414364980][bookmark: _Toc415501418]Move to a Character, Word, Paragraph, Column, or Object
	

	Left Arrow 
	One character to the left

	Right Arrow 
	One character to the right

	Control + Left Arrow 
	One word to the left

	Control + Right Arrow 
	One word to the right

	Control + Up Arrow 
	One paragraph Up

	Control + Down Arrow 
	One paragraph Down

	Alt + Up Arrow 
	To the previous frame or object

	Alt + Down Arrow 
	To the next frame or object

	Shift + Tab 
	One column to the left (in a Table)

	Tab 
	One column to the right (in a Table)

	Up Arrow 
	Up one line

	Down Arrow 
	Down one line

	End 
	To the end of a line

	Home 
	To the beginning of a line

	Alt + Control + Page Up 
	Up one page

	Alt + Control + Page Down 
	Down one page

	Page Up 
	Up one screen

	Page Down 
	Down one screen

	Control + Page Down 
	To the bottom of the screen

	Control + Page Up 
	To the top of the screen

	Control + End 
	To the end of a document

	Control + Home 
	To the beginning of a document

	Shift + F5
	To the location of the insertion point when the document was last closed

	Access and use task panes
	

	F6 
	Move to a task pane from another pane in the program window.

	Control + Tab 
	When a menu or toolbar is active, move to a task pane. 

	Tab or Shift + Tab 
	When a task pane is active, select the next or previous option in the task pane. 

	Control + Down Arrow 
	Display the full set of commands on the task pane menu. 

	Spacebar or Enter 
	Open the selected menu, or perform the action assigned to the selected button. 

	Shift + F10 
	Open a shortcut menu; open a drop-Down menu for the selected gallery item. 

	[bookmark: _Toc37559997]Use the Open and Save As dialog boxes
	

	F12 
	Display the Save As dialog box 

	Shift + F10 
	Display a shortcut menu for a selected item like a folder or file 

	Tab 
	Move between options or areas in the dialog box

	lt + I 
	Open the Look in list 

	F5 
	Update the files visible in the Open or Save As dialog box.

	Move around in a table
	

	Tab 
	Next cell in a row 

	Shift + Tab 
	Previous cell in a row 

	Alt + Home 
	First cell in a row 

	Alt + End 
	Last cell in a row 

	Alt + Page Up 
	First cell in a column 

	Alt + Page Down 
	Last cell in a column 

	Up Arrow 
	Previous row 

	Down Arrow 
	Next row 

	[bookmark: _Toc37560004]Apply character formats
	

	Control + B 
	Apply bold formatting 

	Control + U 
	Apply an underline 

	Control + Shift + W 
	Underline words but not spaces 

	Control + Shift + D 
	Double-underline text 

	Control + Shift + H 
	Apply hidden text formatting 

	Control + I 
	Apply italic formatting 



[bookmark: _Toc320038512]  Internet Explorer Keyboard Commands
	Viewing and Exploring Web Pages
	

	Tab 
	Move forward through the items on a web page

	Shift + Tab 
	Move back through the items on a web page

	Alt + Home 
	Go to your Home Page

	Alt + Right Arrow 
	Go to the next page.

	Alt + Left Arrow or Backspace 
	Go to the previous page

	F5 
	Refresh the current web.

	Esc 
	Stop downloading a page

	Enter 
	Activate a selected link

	Control + H 
	Open History in Explorer bar

	Using the Address Bar
	

	Alt + D 
	Select the text in the Address bar

	F4 
	Display the Address bar history

	Control + Left Arrow 
	Move the cursor left to the next logical break (period or slash)

	Control + Right Arrow 
	Move the cursor right to the next logical break (period or slash)

	Control + Enter 
	Add “http://www.” to the beginning and “.com” to the end of the text typed in the Address bar

	Up Arrow 
	Move forward through the list of AutoComplete matches

	Down Arrow 
	Move back through the list of AutoComplete matches



[bookmark: _Toc320038513]  OutLook  Keyboard Commands
	Control + Shift + O 
	Change HTML or Rich Text to plain text. 

	Control + Shift + B or Alt + Period 
	Show the Address Book

	Control + Shift + >
	Next item (with item open)

	Control + Shift + <
	Previous item (with item open) 

	Control + Q 
	Mark as read 

	Control + R 
	Reply to a mail message

	Control + Shift + R 
	Reply all to a mail message

	Control + Shift + C 
	To create a Contact

	Control + Shift + E 
	To create a Folder

	Control + Shift + M 
	To create a Message 

	Control + S 
	Save

	Alt + S or Control + Enter 
	Send

	Control + P 
	Print

	Control + N 
	New

	Control + D 
	Delete

	F7
	Check Spelling

	Control + F 
	Forward

	Control + M, F5
	Check for new mail

	F6 and Shift + F6
	Move to the next/previous pane

	F6
	Cycle through all the panes in the active window

	Control + Shift + I 
	Switch to Inbox

	Control + Shift + O
	Switch to Outbox

	Control + Y 
	Go to Folder


	
[bookmark: _Toc320038514] PCOM Keyboard Commands
	Home 
	Put PC Cursor in the first editable field or at top of screen

	Control + Home 
	Put PC Cursor in upper left corner of screen

	Tab 
	Move PC cursor to next editable field

	Shift + Tab 
	Move PC cursor to prior editable field



[bookmark: _Toc320038515]  WebCHIP Keyboard Commands	
	F1 
	Display Microsoft Internet Explorer help.

	F3 
	Access the Find All Files application.

	F5 
	Refresh the current page.

	Alt + Spacebar 
	Access the Command Menu Once pressed, use the arrow keys to restore, Move, Size, Minimize, or Maximize the screen. Press Enter when finished.

	Esc 
	Closes the current "pop-up" screen or dialog box.

	Alt + F4 
	Exits the application.

	Alt + Print Screen 
	Copies the screen to the Clip Board. 

	Tab 
	Moves cursor to the next screen feature i.e. button, checkbox.

	Shift + Tab 
	Moves cursor to the previous screen feature i.e. button, checkbox.

	Control + B 
	Opens Internet Explorer's Organize favorite’s screen.

	Control + D 
	Opens Call Detail after initiating a Retrieve function (Menu equivalent of selecting Call - T2 Detail.)

	Control + E 
	Adds a search frame to the screen. Press again to remove.

	Control + F 
	JAWS Find

	Control + G 
	Opens General Info/Other (Menu equivalent of selecting Action - General Info/Other.) Press Alt + C to Close.

	Control + I 
	Opens Call Information (Menu equivalent of selecting Call - Information.)

	Control + J 
	Opens Benefit Estimate (Menu equivalent of selecting Action - Benefit Estimate.)

	Control + K 
	Opens Status of Claim (Menu equivalent of selecting Action - Status of Claim)

	Control + M 
	Opens MDW (Menu equivalent of selecting Action - MDW.)

	Control + N 
	Opens New Call (Menu equivalent of selecting Call - New Call.)

	Control + P 
	Print the current Frame or entire contents of window.

	Control + Q 
	Opens Mainframe Queries (Menu equivalent of selecting Mainframe Workspace - Queries and Inputs.)

	Control + S 
	Saves the current call and opens Call Repository (Menu equivalent of selecting Call - Repository.)

	Control + T 
	Opens NonReceipt (Menu equivalent of selecting Action - NonReceipt.)

	Control + U 
	Opens User Preferences (Menu equivalent of selecting User - Preferences.)

	Control + Y 
	Opens Benefit Verification (Menu equivalent of selecting Action - Benefit Verification.)
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[bookmark: _Toc238226359][bookmark: _Toc320038516]Appendix C - Example Voice Command Library
[bookmark: TSCOG][bookmark: Global][bookmark: _Toc238226360][bookmark: _Toc320038517]Common Commands
Global Commands 
	Command
	Date
	Description

	Appeals Times Call
	01/20/2007
	Opens Internet Explorer from anywhere (whether or not Internet Explorer is already open in another window) then brings up the NETSTAT Report. 

	Back Tab <tnr>
	01/20/2007
	Presses Shift + Tab 1 to 70 times.

	Find Text
	01/20/2007
	Brings up the Find dialog in most applications (same as typing Control + F).

	Minimize All
	01/20/2007
	Minimizes all the open applications so the desktop is visible.
May not minimize WebCHIP in certain screens (but will on Start New Call screen).
This command is written using the DVC format.

	Mouse Position
	01/20/2007
	Captures the present coordinates of the mouse pointer, displays them on screen, and copies them to the clipboard.

	Move Over
	01/20/2007
	Brings up previous application.

	Restore Focus
	01/20/2007
	Clicks the mouse in the middle of the screen to restore the focus.

	Insert Date
	01/20/2007
	Types the date in the format MM-DD-YYYY.
The date format may be modified.


[bookmark: Word][bookmark: _Toc320038518]Microsoft Word Commands 
	Command
	Date
	Description

	Basic Path
	01/20/2007
	Presses the Home key and enters P:\worddata\ in the File Name field of the Save As dialog box.

	Board Open/Close
	01/20/2007
	Opens or closes the Office Clipboard. Say “Board Open” to open the clipboard. Say “Board Close” to close the clipboard.

	Delete to Bottom
	01/20/2007
	Selects everything from the cursor to the bottom of the document and deletes it.

	Word Play 
	01/20/2007
	Calls up the user’s list of MS Word macros.


[bookmark: Internet][bookmark: _Toc320038519]Internet Explorer Commands 
	Command
	Date
	Description

	Mirror Site Call
	01/20/2007
	Opens Internet Explorer (whether or not Internet Explorer is already open in another window) and opens the mirror site to the Social Security Online homepage.

	Policy Home Call
	01/20/2007
	Opens Internet Explorer (whether or not Internet Explorer is already open in another window) and brings up PolicyNet's Home page.  This command may be run from anywhere.

	Policy Search Call
	01/20/2007
	Opens Internet Explorer (whether or not Internet Explorer is already open in another window) and brings up PolicyNet's Advance Search page. This command may be run from anywhere.

	Open Google
	2/23/2007
	Opens Internet Explorer to www.google.com.

	Open Macro Library
	2/23/2007
	Opens Internet Explorer to http://ssahost.ba.ssa.gov/dcscewd/DragonMacros/AvailableCommands.htm 


[bookmark: PCOM][bookmark: _Toc320038520]PCOM Voice Commands 
	Command
	Date
	Description

	Benefit Next
	12/15/2006
	Runs the PCOM macro DNS_BENENEXT, which moves user from initial BEVE screen to BEVE final screen, places a "1" in the Select Notice Type field, and moves the cursor to the Paragraph field.

	Benefit Remarks
	12/15/2006
	Runs PCOM macro DNS_BENERMKS, which takes cursor to beginning of the first Remarks line. 

	Claims Lead Unit
	12/15/2006
	In the Unit field of the LPF2 screen, types in the TSC office code and moves cursor to the Claims Type 1 field. The Unit Code must be edited for each user.

	Record <A-Z>
	12/15/2006
	Records a temporary PCOM macro under the letter selected, replacing the previous macro by that name. For example: the user says “Record s” or “Record sierra”, dictates SSN into field then says “PCOM save” to save the macro.  PCOM will overlay the previous temporary macro named S with the SSN just dictated.

	PCOM Save
	12/15/2006
	Saves the PCOM macro you have just recorded.  This command is used with PCOM Record and PCOM Deliver <A – Z>.

	Deliver <A-Z>
	12/15/2006
	Plays a temporary PCOM macro named the letter selected. For example: the user says “Deliver s” or "Deliver sierra”. PCOM will play the most recent macro recorded as S. 

	PCOM Play
	12/15/2006
	Brings up your list of PCOM macros so you can select the one to execute. 

	PCOM Record
	12/15/2006
	Brings up PCOM’s macro record box and moves the cursor to the macro name field. After providing a name, select the OK button and PCOM will record all keystrokes until you say “PCOM Save.”


[bookmark: MasterTemplates][bookmark: _Toc238226361]R/SR Command
TSCOG Commands 
	Command
	Date
	Description

	QMB Call
	01/20/2007
	Opens the TSCOG from anywhere (even if that is already open in another window) and brings up the page TC 23001.040 Comparison Of QMB, SLMB, QI, and QDWI. 

	Tea Sog Fraud Call
	01/20/2007
	Opens Internet Explorer from anywhere (whether or not Internet Explorer is already open in another window) and brings up the TSCOG section dealing w/fraud reports. 

	Tea Sog Keyword 
	01/20/2007
	Moves the cursor to the Keyword Search field on the TSCOG Table of Contents page. Run immediately after opening the TSCOG Table of Contents. Do not tab first.

	Tea Sog Table Call
	01/20/2007
	Opens Internet Explorer from anywhere (whether or not Internet Explorer is already open in another window) and brings up the Table of Contents to the Teleservice Operating Guide. 


[bookmark: WebChip] WebCHIP Commands 
	Command
	Date
	Description

	Big Caller ID 
	01/20/2007
	Brings up the General Caller screen. This command is used when separate Social Security numbers have been entered for the claimant and the caller.

	Big Modify Call
	01/20/2007
	Brings up the Modify Call screen.

	Chip Center
	01/20/2007
	Moves the focus to the bottom-center of the screen. For example: On CHIP’s Queries And Inputs screen,  the focus is currently on the left pane (with the list of CHIP topics) and you want it switched to inside the center-of -screen box which lists  available queries and inputs.

	Chip Instructions
	01/20/2007
	Takes all Information/Instructions text on a WebCHIP page and transfers it to a WORD document in regular text format. Microsoft Word must NOT be open when you run this macro – the macro will open Word.

	Chip Keyword 
	01/20/2007
	Selects the Keyword Search link, and brings up the Keyword Search screen. The Position Bar for CHIP macro must be run first.



[bookmark: _Toc238226362][bookmark: _Toc320038521]
CR Commands
EDCS Commands 
	Add Extension
	1/15/07
	Adds the CR’s telephone extension to the appropriate telephone extension fields. The telephone extension number must be edited for the new user.

	Add Test <ltest>
	1/15/07
	From the Test Information screen, selects the test from the list and Tabs to the appropriate field. For the Biopsy, MRI, and X-Ray tests, the command accesses the “Show Dictation Box”. The user should be familiar with the terminology used for each test.

	Answer <yn>
	1/15/07
	On the “Yes”, “No”, “Not Yet Answered” fields, selects the “Yes” or “No” radial button. User dictates “Answer Yes”, or “Answer No”.

	Flag <type>
	1/15/07
	Selects Homicidal, Homeless, Prototype, Representative, Suicide, or Terminal Flag on the Flag Information screen. This list may be edited to suit the needs of the user.

	Form <fnumber>
	1/15/07
	From any screen in EDCS, accesses the eForms screen and selects SSA-820 Work Activity Report (Self Employed Person), SSA-821 Work Activity Report - Employee, SSA-827 Authorization to Disclose Information to SSA, or Report of Contact form. This list may be edited by the user.

	Get Started
	1/15/07
	From The Desktop, opens Outlook, VIP, PCOM, and EDCS.

	Number EDCS
	1/15/07
	From any PCOM selects and copies a SSN, switches to EDCS and pastes the SSN into the SSN field.


[bookmark: VIP]
VIP Commands 
	Appointment <alist> 
	1/15/07
	From Queries and Reports, Appointment Information Query screen selects the specified Contact or Appointment information field radial button and tabs into the edit field (i.e. “Appointment Claimant SSN).

	Appointment Two <alist2>
	1/15/07
	This command would be used if there were two criteria and Appointment <alist> had already been used. Appointment Two <alist2> will only work correctly if the desired criteria follows the criteria selected by Appointment <alist>.

	Assign <name><event>
	1/15/07
	On the Employee Schedule screen, selects an individual and assigns “Leave”, “Walk-in”, or “Blocked”. The user must edit the names list.

	VIP <option>
	1/15/07
	Selects Appointment, Contact, Schedule, Management, Messages, Queries, Utilities, or Exit from the VIP Main Menu screen.
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